2.6.2.3 User’s Guide for Computer-Aided Planning

1. INTRODUCTION

The PW4SP Data Management User’s Guide explains the procedure of encoding data and

generating tables and figures for the PW4SP. The Guide consists of the following sections.

. Section 2: hardware and software required to successfully run the PW4SP Data
Management System

. Section 3: the concept of the microcomputer architecture and an overview of hardware
configurations
* Section 4: fundamentals to operate the system with internal architecture

* Section 5: basic concept of sofware operation

* Section 6: a complete list of data files and worksheets in the PW4SP Data Managemend
System :

* Section 7: data iinkages
. Section 8: the procedure of updating the PW4SP

*  Section 9: standard report format
2 SYSTEM REQUIREMENTS

The following are the basic requirement to successfully nan the PWA4SP data wmanagement.

Hardware: . ‘ ' Software:

C Computer: 80486 CPU at 66 Mz, Operalillg System: . DOS Ver. 622
RAM: | ‘& MB {minimum) Windows Environment: MS-Window Ver 3.t
Hard Disk: 200 MB Gnininum) ~'Spreadsheet: MS-Excel Ver 5.0
Floppy Drive: 3.5 inch, High Density Word Pro'ccssing:. MS-Word Ver 6.0

5.25 inch, High Density |
Monitor: VGA Monitor
Printer: 80 column

{Can handle A4 size paper).
Mouse: Any brand which supported
by MS-Windows

Miscellaneous: 500 walts Automatic Voltage

Regufator and Surge Protector
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MICROCOMPUTER SYSTEM

All computers, whether large or small, basically eperate on the same fundamental principles.
The hardware and software of a mainframe computer and a microcomputer have the same

components and fulfill the basic functions necessary to any computer system.

The compuler is seen as a powerful tool that can enable us to expand the horizons of our

“knowledge. It allows processing of large volume of data or complex pattern of infarmation

that would otherwise be difficult to organize and understand. - Moreover, it allows for an
easily manipulation of data.

There are two major components of a microcomputer: the hardware and the software. These

two components complement each other in order to fulfill their basic function.

A microcomputer hardware is made up of several components based on the functions they

perform in the system and how they interact with the other components.

The principal elements of a corpater system are:

e Central Processing Unit (CPU)

"o Main Memory (RAM)

"« Secondary Storage Devices (disk, drives, magnetic tapes, eic.)
* [ Input/Output Devices (terminals, printers, etc.)

The CPU does the actval computing. It is capable of simple arithmetic and logical -

~operations, such as addition and data comparison, that are executed at exceedingly high

speed. The power of a computer directly stems from the speed and accuracy with which the

-CPU can carry out computations and move information around. The main memory of the

boanputer is usually referred to as Random Access Memory or RAM. This part of the
computer contains the progr_m'ns and information that are curcently being processed by the
CPU. Secondary storage devices, such as magnetic disk, is capable of holding large amount
of data. Programs and data are normally stored on these secondary devices and could be
retrieved when needed. They are then loaded into the RAM and executed. The results of the

processing can then be written into the secondury storage device or sent to an outpul device

“such as the monitor or printer. Peripheral devices or [nput/Output (I/0} devices allow the

user to put data into a computer or receive output from a computer. A teeminal is a
peripheral that contains both a keyboard for input and a monitor for ouiput.  Other

peripherals include printers and plotters.
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The diagram below presents the basic hardware component of a microcompater system.

pt Central Processing Unit| o

(CPU)
I/O Terminal l Secondary Storage
A
Random Access Memory
Keyboard (RAM)
lgp] Hard Disk
Monitor g
.,q_bl Floppy Drive
Printer  [g-d S

Floppy Drive is the most conunon Lypé secondary storage used in personal computer today. .
It acts as an external drive from which the users insert the floppy disk to store and refrieve
information. The floppy disk comes in three sizes: 3.5 inches, 5.25 inches and 8 inches. Itis
characterized by thin circular plastic sheets conted with iron oxide so that magnetic patterns
recorded on it can be retained. The surface is similar to a magnetic lape used to record
music. The disk is contained in a square cardboard envelope in which it'spins. ‘The 3.5
" inches diskette is contained in a hard plastic case with a metal shuiter that protects' the
¢ magnctic media. A'ﬂoppy disk-can store from 80 kilobyies to 1.44 mégabytes of data.
‘Floppy disk system is stower and has less storage capacity than hard disk system, but its

lower cost makes it a popular choice for personal computer.

Hard disk is made of maganetic metal, and can either be removable or non-removable. The
most common lype of hard disk found in personal computer today is non-remavable.  This
disk typically hoids‘froi‘n 10 megabytes to 1.5 gigabytes of information. Each megabyle is
equivalent to '1,048,5?6.charaders of information, or roughly 1,800 single-spaced typewritten

pages: heace, this is a very efficient way to store Jarge volume of information.

Keyboard is an external device that acts as a primary interface between the human operator
and the computer. The keyboard has 3 basic components: the typewriter keyboard which is
composed of alphabet characters; the calculator pad which is composed of numeric

characters; and the function keys which serve as special macro key for various softwares.
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1

Monitor is the screen or video display peripheral and serves as the main output device on a
personal computer. It is used to display text and grapﬁics infoermation and is available in a
variety of sizes and types. Monitors can be divided into two broad groups: those designed to
display text information; and those designed to display graphics information, such as charls
or picture. Within the graphics group, there are color or monochrome (single color) displays.
A high quality graphic color monitor is capable of showing high resolution pattern and is

recommended for application in MS-Window, Excel, or AutoCAD.

Printer is another common peripheral found in personal computer system. The 2 commen
type of printers are dot matrix and {aser printer. The dot matrix printer produces its image by
printing a group of dots that forms the image of a character or symbol. Several methods are
used lo create the pattern of dots. The most common are impacl, thermal, and ink-jet
technologies. The laser printer produces its image by means of electrophotograph similar to

the principle of photocopy machine.

OPERATING SYSTEM

An operating system is a set of control program that manages the computer’s resources and

create a well-defined software environment for computer applications. Computer hardware

by itself can perform little useful work.” A computer requires a software to be able to

- communicate and do useful work. The first layer of software in a computer system is the

operaiin.g system. This is what starts, or boots up, the machine helps in pulling itself up by
its own bootstraps and establishes a predetermined set of conditions so that applications can
be run. When the computer is turned-on ar the reset button is pressed, the control is pass toa
set of control programs found in the ROM, a firmware store in computer chips. These
programs perform several tasks: (1) to check if hardwares are functioning correctly; (2) to
load a set of conteol program from the disk to the memory; and (3) to pass conteol to a routine
which will accept the user input. At this point, the operating system is loaded and the user

can execute an application program such as MS-Windows, MS-Word, or Excel.

An operating system by itself has iwo levels of functionality. The first level is seen by the

“user running the applications and utilizing system commands and utilities. At this level, each

operating sysiem has its own set of conunand used to accomplish frequently performed tasks
such as copying files, renaming files, and formatting disks.  Normally, frequently-used
functions are included in the operating system as system commands. The sccond is at the
programming level. Al operating systems contain a set of pre-packaged coutine which

performs the “primitive” functions necessary in ahmost all applications. Such functions, like
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5.1.

sending a character to the screen, reading and writing information from a disk file, and
accepling input from the keyboard are common to nearly all programs. This level of

functionality gives the programmer a sct of standardized routines to perform this task.

Operating systems, such as DOS or UNIX contain many useful utilities and provide a rich set
of function, which simplify the programmer’s job writing application and controlling the

hardwares.

SOFTWARE

The operating system atone renders the coinputer nearly useless, unless the user is capable of
directly communicating to the hardware. In order (o use the computer systen, a software. is
needed. Various softwares are available for different purposes, such as MS-Word for word

processing, Excel for spreadsheet and Foxpro for programming. -
MS-WINDOWS

MS-Windows is a popular software that duplicates the function 'perfdnned by DOS at the
system level. Most of the commands are represented by descriptive figures called icons.
Navigating acound the windows is through a pointing device called mouse. To execute a
command, the user only need to bring the mouse poinlér to the dgsired'command described
by the icon and press the right button. The execution stasts without lyping any single
character in the keyboard, unlike the DOS ¢onvention that needs typing a series of characters
comprising the filename. In windows, the computer screen is refecced to as the desktop.
When working, the application and documents must be in the windows. The windows on the
desktop must also be arranged. If an application is left for a while, the windows are shrunk to
an application icony, and still, the applic-miosi keeps running on the background. When an
application is shrunk, the windows place their application icon at the bottom edge of the

desktop uatil it is again restored to window size.

‘With windows, several powerful applications can be run simultaneously.  For example,

~ switching from a word processing application to a spreadsheet, and then to database

application with a few simple moves while quitting one application and restarling another,

can easily be done.
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Two Kinds of Windows

Application windows contain running applications. The name of the application, the
associated document, and the application’s menu bar appear at the top of the-application

window. Application windows can be positioned anywhere within the desktop borders.

Document windows appear only with application that can open 1wo or more documents at one
timie inside the same workspace. For example, with Windows File Manager, one can open a
number of directories at the same time. Each directory appears in a separate document

window (called a directory windowy) in the File Manager workspace.

Parts of a Windows

Each application and some docuinents the user choose to work on, open as separate windows.

Every window has some commaon elemients, however, not all windows use all the items.

The elements as tllustrated below are the tools for working wilth the window and the

application or document within the window.

tasertion point ' ‘Window titl _ Minimize butica
'~ Conirol-meny box / - o Title bar -~ Maximize butlol
. [ cl ] w . ‘—*T- Many bar
] _ SR AT S
. b
. Windovs boed?!
—— Ventical
scroll bar
: - ' n
I X, _ O N
\ Window corner \- tousz pointer \ Horizantal scrofl bar

The Controf-menu box located in the upper-left comer of the window ix the most uselul
menu when the use of a keyboard is preferred. The Control-menu communds can resize.

move, maximize, minimize and close windows, und switch to Task List.
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The title bar shows the name of the application or document. If more than one window is
open, the title bar of the active window has a different color or intensity compared to the
other title bars.

The window title, depending on the type of window it appears, can be the name of an
application and the name of the document, or a placeholder. In such case, “wntitled”
normally appears. '

~ The menu bar lists the available menus. Most applications have a File menu, an Edit menu,

and a Help menu as well as other menus unigue to the application.

The Scrolf bar can move the pards of the document inlo view when the entire document will
not fit in the window. With the bar, unseen portion of the lists and other information that is

ioo long to fit in the allotted space can also be viewed.

- The Maximize and Minimize buttons enlarge the active application window to fill the entire
desktop or shrink the window to an icon. Document windows enlarge. just to fill the
application workspace and not the entire desktop. After enlarging the window, the Maximize
button changes 1o a Restore button. . Restore button ¢an be used to return the window to its
previous size.

The Window border is the outside edge of a window. It can lengthen or shorten each side of

the border. -
The Window corner can be used to shorten or lengthen two sides of a border at the same time.

The Workspace is where most of the work with an application are done. For example. the
content of the documents appears in the workspace when starting a wordprocessor. Hence,
an application can allow the opening of more than one document window within this

workspace.

* The selection cursor shows where the user is in an individual document. It marks the place
in the text or graphics where the user begins typing or drawing. The arrow-shape mouse
pointer appears if you have a mouse installed. It is used to indicate items the user wanis to

select with mouse.
Starting Windows

At the DOS prompt, type win and press ENTER.
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When starting windows, the Program Manager window 1is automatically opened with ths

Main Group window opening inside it and other window groups represeated as group icons

located at the lower edge of the Program Manager window as show ia the illustration in

below,

N
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Quitting Windows

Mouse 1. Quit any application that are currently running.

. Click Program Manager's File menu to open it

. Click Exit Windows.

The Exit Windows confirmation dialog box appearh
. Click OK 1o exit windows.

i

£

Kevboard 1. Quit any application that ace currenily running.
Press ALT-F to open Program Manager’s File Menu,
. Press X (the underlined letter in Exit).
Or use arrow key to move the highlight to Exit Window
and the press ENTER. ' '
.The Exit Windows confirmation dialog box appears.
" 4, Press ENTER to choose OK and exit windows, -

[

-t

Starting Window Application
To muke starting application easy, Window ofters three methods:
Choose a program item from a group window in Program Munager..

Ik -3
g Choose a progeam file from the appropriate directory window in File M.umwu

Choose the Run command Fram the File menu in Program Manager or File Munager.
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Starting Applications from Program Manager

As long as an application belongs to a group, the easiest way to start is to choose from the
group window. If a document is included with the application, it will be loaded into the

application workspace.

Mouse 1. Open the Program Manager window, if not already open,
and open the group wiridow that contain the application
you want to start.

2. Double-click the icon for the application.

Keyboard 1. Open the Program Manager window, if not already open,
' and open the group window that contain the application
you want to starl.
2. Use the arrow keys to move the highlight to the icon for
~ application. '
3. Choose Open from the File menu and press ENTER.

Starting Applications from File Manager

You slart an application from File Manager by 0pe|iing the program fite from a directory
window. You ¢an execute an application program file having .COM, EXE, .PIF, or .BAT
filename extension. [f the application can run in a window environment, the window will

appear in front of any File Manager windows that are opea.

Mouse I. Stast File Manager and open the dircctory window
that contain the program file.
2. Double-click the filename.

- Keyboard k. Start File Manager and open the direclory window
that contain the program file.

2. Use the arrow keys lo move the highlight to the icon for
application. .

3. Choose Open from the File menu and press ENTER.

Starting Applications with the Run Command

The Run command is a handy way to start applications that you want to cun only occasionally
or have not yet added to a group.  You can open a document at the same lime you start the
application. Unless the program file is in your current path, you need to know the exact

directory location and name of the program file before you can start the application.

1. Choose Run from the File menu in Program Manager or Fite Manager.
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5.2,

The Run dialog box appeats.

2. Type the pathname and the exact filename of the program file, including
the extension if there is one.

3.1f you want the application to shrink to an icon as soon as it starts, make
sure the Run Minimized check box contain an X.

4. Choose OK or press ENTER.

MS-EXCEL

Excel is a spreadsheet type of software package that operates under the MS-WINDOWS
operating systemm. The primary document in Excel is called a workbook. The workbook is
similar to a ledger that stores information and each workbook is made up of sheets. The
sheet is virtvally divided into colirnn and row; the column run horizontally and denoted by an
alphabet starting with A and the row run vertically aﬁd denoted by number starting from 1.
The intersection of column and row is called cell. The cell is the basic component of
worksheet that accept different data types. The most common data types -are charaléler,

number, date, logical value and formula.
Standard Tootbar

The standard toolbar that normally appears at the top of screen helps select options. Such

options can open workbook, print and save worksheet, and ask for help. The following is &

list of the individual icons and their respective functions.

Excel’s Standard Toolbar

Button Nome Function
0 _ .
New Workbook Creates a new workbook B
Ty
le Open Opensadocument o
E Save Saves the active workbbok
. : |
@ Print Pring the active workbgok o
H@"— Print Preview Shows the active docementin print preview
mode
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Excel’s Stondard Toolbur“

Bution Nome ) Function
N Speller Checks the spelling of the document
P . .
: Cut Cuts the selection o the Clipboard

&
2 Copy Copies the étlecdon ta the Clipboard

% Paste Places the Clipboard contents at the inserdon
o point
;'g._'~
e Format Painter Copies and pastes formats for cells and objects
| i
o .

] Undo Undoes the tast action or command
Fower
5@“5‘ Repeat Repeats che lastacdon or command;
S : this is the same as the redo feature in Word 6
B , |
e CAutoSum " Inserts the SUM Function 2ad shows sum range
e Yunedon Wizard Starts the Funcdon Wizard
Z Sort Asceading Sorts setected rows in ascending order
,;fﬁ_m_ Soit Descending Sorts selected rows ta desceading ordar

ChacWizard Activatas the Char¢Wizard
Text Box _ [nseets 1ot or text hox
%
Draving _ Turns the draving toolbac on or off
ife= .
p4 = . -
100 [ias Zoom Controel ~  Sets the view of the docwimeat

Tip Wizard Turns tre TipWizard wookbar on ov nfl

Help Displays Help
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Excel’s Formatting Yoolbar

Bution

Nome

Function

Argial

_“M__W“J EE] Font

Sets the font for the selection

16 I Fonut Size Sews the font size for the
| T M selection

333

gtk o
bt " Bold Boldfaces the setecdon
¥ ' -

7] . - . .
fory Jalic Ialicizes the selection
'w!'h
%——‘ Underline Underlines the selection

Align Left

Lefialigns the selection

=,
4
Fl4s

Center Ceanters the selection
o Align Right  Right-aligns the selecdon
= ‘Ceater Across Centers the selecton across
el Columns ¢olumns
: f{g Currency © Changes the s¢lected cells w0
e Style - . defautt currency sole
' r{'?/" 3 . . Percenu Changes the seleced cells w0
o N :
k) ) _ Sgle default percentsiyle
& Comma Changes the selected cells 0
oA Sple default comma sole
_'g?;‘o, Increase Adds one decimal place (o
9 Decimal the numnber format
B : Decreass Rémoves one decimal place
add Decimal from the aumber formaz
1'% Borders Enables you {O:SCicctl:\
il ol _border for the seleciion
Color Scis the color for the

sclection

s
R

Font Color

Ses the color for the selecied
font :
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Basic Part of Excel Sercen
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MS-Excel Basic Operation Tobs - Workdhest

Following the description of the basic operation, the mouse is used as a pointing device

instead of a keyboard. “The word:dick means the user must press the left button of the @

mouse; double click means two successive clicks; and enter means the user must préss the

Enter key in the keyboard. Basic operation dealt only to the foutine necessary to update the

PWA4SP daa base.

Creating a New Worksheel

When you enter Excel. it opens up to a new workbook, by default it contain 16 worksheets.
You cun use any of the worksheets. Even if there is an open workbook, you cun still open
another by mioving the mouse pointer in the New icon {upper left of the screen below the

menu bar). Click on it

Saving the Workbéok .

1. Move mouse pointer to File menauw and click ou it to bring the File menu option.

2. From the option available. Select Save,

3. If the document your saving is new. The Save As dialog box appeur. fix the File Name
box type the mame of the workbook,

Enter Data in o Cell g
). First select the ceff by moving the mouse pointer and clicking the
i

right button. This routine place the iasertion point in the active cell,
which is highlighted on-screen with border avouwnd it

2-114



2. You can stait entering the data from your keyboard or numeric keypad.
3. To confirm the inpul, you can press ENTER or move the mouse pointer
@ to the Formula bar and click the Check icon.

Editing Cell Contents

{. Double-click the cell containing the data you want to edit.
To edit in the formula bar, click in the formula bar. In case the formula
bar is not displayed, choose Formula Bar from the View menu located
at the top row of screen.

2. Edit the cell contents. _

3 To confirm the modification made in the cell, click the Check icon in the
formula bar or press ENTER. To cancel edits, click the X icon in the
formula bar or press ESC.

Clearing Cells

1. Select a cell or range of cells that you want to clear.

2. From the Edit menu, choose Clear, and from the option available,
you the choose All, Contents, Formals, or Notes.

* Sheortcut: Press DEL. e

To clear cells by dragging

- 1. Select a cell or range of cells that you want to clear.
fg}‘ 2. Move the mouse pointer in the jifl handle (lower right corper),
drag the fill handle toward the area of cell or range, then the selected
area will become gray.
3. Release the mouse button.

"Copying Cells

1. Select the cells containing the data you want lo copy.
2. From the Edit menu, choose Copy.
‘3. Select the upper-left cell of the paste area.
Beware that any values or formula in the paste area will be replaced.

Undo Command

1."To undo your last command, click the Undo button.
From the Edit menu, choose Undo.

Creating Border around Cell

I. Choose the Cell menu from Format menu.
2. Choose the side you want put the border, and then choose type of border.
3. Click OK button.

g Deleting Rows and Colurims

1. Select the row or column
To delete more than one row or column, extend the selection to tnclude
all the rows or columns you want {0 delete.
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2. From the Edit menu, choose delete (Entire rows or column)
3. Click OK button

Inserting Rows and Columns

1. Select the row or column
To insert more than ong row or column, extend the selection to include
the number of rows or columns you want to insert.

2. From the Edit menu, choose Insert {Entire rows or column)

3. Click OK button.

Selecting a Sheet or Sheets
To sélect a single sheet, click the sheet tab.
To select two or more sheets
|. Click the sheet tab for the first sheet you want to select.
2. If the sheets you want to select are adjacent, hold down the SHIFT key
and click the tab for the last sheet.
If the sheets you want to select are non-adjacent, hold down the CTRL key
and click the other sheet tabs.
Ungroup Selected Sheets
- 1. Move the mouse pointer to the sheet tab. Click the left button of the mouse.

2. While the mouse pointer still on the sheet tab, click the right button and .
-choose the Ungroup Sheets.

Inserting Workshécl

1. Select a sheet or sheets in the workbook.
2. From the Insert menu, choose Worksheet.

The new sheet of sheets will be inserted to the left of the sheet tab you select.

Shortcul: - SHIFT+FL
Deleting Workshect

I. Select a sheet or sheets in the workbook.
2. Move the mouse pointer to the sheet tab, and click the n0ht button.
i Choose Delete, and c]:ck the OK button.

Moving Worksheet Within the Werkbook

1. Select the sheet or sheets you want (o move.

2. Drag the selected sheet tab along the row of tabs.
A black triangle indicates the place where the sheets will be inserted.
Al selected sheets will be inseried.

3. Retease the mouse button.
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Alternate Method

t. Select the sheel or shects you want to move.

2. From the Edit menu, choose Move or Copy Sheet.

3. In the Before Sheet box, select where you want sheets to be insedted.
4. Click the OK bution.

Moving Sheets to Other Workbook

1. Open the workbooks you want ta move sheets fo and from.

2. Select the sheet or sheets you want to move.

3. From the Edit menu, choose Moave or Copy Sheet.

4. In the To Book box, select the destination workbook.

S. In the Before Sheet box, select where you want the sheet or sheets inserted.
6. Click OK button..

Alternative Method

1. Open the workbooks you want to move sheets fo and from.
2. From Window menu, choose Arrange and choose horizontal.

In the desktop, two workbooks will open in screen split the workarea honzonlally.
. Select the sheet or sheets you want lo move.

4. Hold-down the CTRL key and the right button of the mouse. -

A paper icon and black triangle indicate that you made the move routine active.

5. Drag the mouse pointer to the other workbook and select where you want

~ the sheet or sheets inserted.
- 6. Release the mouse button.

[¥S)

Copying sheets within a workbook

1. Select the sheet or sheets you want o copy.’

2. Hold down the CTRL key and mouse left button, and then drag the seieclnd
- sheet tab along the row of tabs. A black triangle md:cates the place where

* the copied sheet will be inserted.

3. Release the mouse button and then the key.

* Altemative Method

i. Select the sheet or sheets you wont to copy.

2. From the edit menu, choose Move or Copy Sheet. : :
3. In the Before Sheet box, select where you want the copled sheet inserted.
4, Select the Create A Copy check box.

5. Ctick the OK button.

Copying sheets to other workbook

1. Open the workbook you want to copy to and from.

. Select the sheet or sheets you want ta copy.

From the Edit menu, choose Move Ot Copy Sheet.

In the To Book box, select the destination workbook.

In the Before Sheet box, select where you want the copied sheet inserted.
Select the Create A Copy check box.

Choose the OK Button,

MO e
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5.3.

Printing your Work

L. From File menu, choose Page Setup to display the Page Setup dizlog box.
2. On Page Setup dialog box, their are four option available

Page tab conteols page orientation, scaling, page size, print quality, and
starting page number for the selected sheet.

Margin tab controls page margins and the header and footer margins, and

. center the sheet on the page verticatly, horizontally or both.

Header/Footer tab controls page the headers and footers for the selected sheet.
headers and footers are descriptive text that print at the top and bottorn of
every page in your sheel, You can add, delete, edit, format, and position
headers and footers, and view them as they will print.

Sheet tab specifies which areas of the sheet you want to print, and controls
the print titles, page order, and draft quality. Alse contrals whether
gridlines, cell notes, and row and column heading print. The Sheet tab is

- displayed if the aclive sheet is a worksheet or macro sheet.
3. On the Print What, their are three option available.

Selection option prints onty the selected cells in the selected sheets.
Nonadjacent selections are printed on separate pages. Selecting this
overrides any print arcas you have defined for the selected sheets using
Print Area option on the Sheet tab of the Page Setup dialog box.

Selected Sheets option prints the area of each of the currently selected sheets,
with each print area starting on a different page. If no print area is defined
on a separate sheet, the entire sheet is printed.

Entire Workbook option prints the entire print area of all sheets in the active
workbook. If a sheet docs not have a print area, that entire sheet is printed.

4. On the Copies box, specifies the number of copies to print.
3. On the Page Range, their are two option available.

All option print all the pages in the selected sheets.

Page(s) option print the range of pages specified in the From and To bowes
Page numbers you selected i in the From and To boxes affect which cells
will be printed, not the numbering of the pages upon which they are
pnnted. To change the numbering of printed pages, specify a number in
the First Page Number box of the Page tab in the Page Setup dialog box.

6. The user have option to see the appearance of the print by clicking the

Print Preview button.

7. Printer Setup option give the user an option to select among the available
printer drivers.
8. Click the OK button to proceed printing.

MS-WORD

MS-Word is word processing type of software. This is analogous of converting your
computer into typewriter machine. You have page in which you type characters, you have a

ruler that show where you are as you type across the page. You have tabs stops und mwargin

~settings. The insertion point moving across the page even acts like the print head moving

across the page.
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MS-Word offer more advance features that you need to create from simple to complex type
of document. When you start Word you will notice almost the identical appearance with that
of MS-Excel. Most of the command are represented in terms of icon, in the middie of the

workspace were you enter your text and other object included in your documents.”
Starting Word

From the MS-Window environment, you can double-click the MS-Word icen in the MS-
Office program group. In some case the MS-Office administrator is automatically loaded at
start-up of Windows environment. The MS-Office administrator menu icons are located in

the upper right side of the screen. You can statt MS-Word by clicking the icon.
Quiting Word

1. Move mouse pointer to File menu and click. File sub-menu will appear.

2. From the File sub-menu, move mouse pointer to Exit option and click.
The MS-Word environment will normaily terminate. In some cases, if some active
documents has not yet been save. MS-Word give the user’s option to save the
documents. Lo

- Standard Toolbar

" “The standard toolbar which normally shown at the top of screen helps you select the opiion,

from this toolbar. The user's can open new document, open existing document, print and save
document, and ask help to farther understand some function or procedure to accomplish
desired task. Using the toolbac speed-up the desire task instead of using the menu (located at

the top of the screen). The following shows the list of standard toolbar icons and their

function.
Standard Toobar lcons
~ leon Nome Descriplion

o
: New Creates a new file based on the Normal cemplate
o Open . ' Displays'lhe'()pcn dialog box so that you can select an

existing {tle 10 open ' L

Q Save Saves the current document
@ Pring Prints the current docwment
@' Print Preview Activates Word's print preview features
ng
e Spelting “[nitiates a spelling check
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Standard Toobar lcons

fcon Nome Description
b Cut Cuuts selected material 1o the Windows Clipboard
Copy ~ Copies selected material to the Clipboard
‘ @ Paste Pastes marerial from the Clipboard into your docu-
ment
’,@ Format Painter  Copies the formatting of  s¢lection to the text you
ol specify
¥l Undo Undoes the commands you select fron the list
i presented
FSA1E] Redo Redoes the commands you select from the list pre-
s b
o sented

ooy
]

AutoFormat Formarts your document automatically

Insert AwtoText  Inserts an AutoText enury
== Insert Table Inseris 4 table into your document

Insert Excel - Inserts an Excel worksheetinto

Worksheet - your document

" Columns Formats your document using columns ' %

i Drawing Opeas the drawing application and enables you 0
= : + draw a picture in your document :
T :
EH ' . -

Insert Chart Inserts a chart into your document
T Zoom Conural - Scales your view of the doctiment by the peccentage
o " you select -

k = Help

Activates contextsensitive help

MS-Word Basic Operation
* Opening and Existing Document

R C!ick_t"ne Open Folder icon (normally second from the left} to bring up the open
- dialog box. '
~ 2. In the Open Dialog box, select the file you to open from File Name combination
box.
3. Click the OK button,

"~ Changing the Format of the Text

I. Click the arcow button to the right of the fonrs box to bring the list of available font.

2. Scroll through the list box by clicking on the scroll bar, and select it font by chicking
onil.

3. Begin typing. The text will appear in the font you just sefected.
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Changing the Font Size

1. Click the arrow button to the right of the font size box to bring the list of available
size.

2. Scroll through the list box by clicking on the scroll bar, and select a size by clicking
on il.

3. Begin type. The lext will appear in the font size you size selected.

Choose a Style

Perform any of the following procedures to change a font style:
¢ Click on the button labeled B to set the bold feature on.
You also can press Ciel+B from the keyboard.
e Click on the button labeled I to set the italic feature on.
You also can press Ciel+] from the keyboard.
o Click on the button labeled U to set the underlined feature on.
You also can press Ctel+U from the keyboard. '
e Ctlick on the button labeled B and I to set both bold and italic features
You also can press Ctel+8 followed by Ctrl+I from the keyboard.

Setting Special Effects

" You can use a variety of special text effects:

Strikethrough
Superscript
Subscript

- Hidden
Small caps
All caps

To set any of these features, use the following procedure:.

_ l. Open the Format menu and select the Font itein.
2. If the Forits tab is not on top, click on it.
3. In the Effect group box, select lhe check box that represent the special effect
. you want lo turiy on.
- 4. Click the OK button.
S. Begin typing. Your text appears with the special effect you sclected.

* Setting the Indentation

.1. Open the Fgrmat menu and select the Paragraph item.

2. If the Indents and spacing tab is not on top. click on it.

3. In the indentation group box, use the Left and Right spin boxes o set the indentation
from the left and right margmq Click on the arrow buttons until the measurement is
correct, or select the text in the body by highlighting it with the mouse und then type
exact measurement you want.

4. To set first line or hanging indentation, open the Special drop down list box by
clicking on its arrow, and select the appropriate item. Use the By spin box to set the
measurement for the first line indentation or the hanging indentation.

5. Click the OK button. Your current parageaph takes on the indentation you just set.
ach subsequent paragraph you create takes on this pattern, unfess you reset the
indentation using the dialog box.
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Setting Line Spacing

1. Open the Format menu and select the Paragraph item.

2. If the Indents and Spacing tab is not on top, click on it.

3. In the Spacing group box, use the Before and After spin boxes to set the distance in
points from the previous paragraph and from the following paragraph. Click on the
arcow bultons until the measurement is correct, or select the text in the box by
highlighting it with the mouse and then type the exact measurement you want.

4. To set line spacing within the paragraph, open the Line Spacing drop-down list box by
clicking on its arrow, and select the appropriate item. Then use the At spin box to set
the measurement for number of tines or distance between lines, whichever is active.

5. Click the OK button. Your current paragraph takes on the line spacing you just set,
Each subsequent paragraph you create takes on this pattern, unless you reset the line
spacing using the dialog box. '

Copying and Inserting Text

1. Highlight the text by dragging the imouse pointer over the text to be selected.

2. Move pointer to Copy icon and click on il _

3. Move mouse pointer to the place were you would like the insertion take place.

4, Move mouse pointer to Paste icon and click on it. Alternatively, you can press the right
buiton of the mouse to bring the inenu option., select the paste by click onit,

- Undoing and Redoing

If you do make a mistake, you can undo it by selecting the Undo option from the Edit menu.
This procedure undoes the last change you made to the document. Word always will add the
name of the operation you are about to undo as the‘s'ecoﬁd word of the Undo menu item. If

you cantiot undo anything, this option change to Can't Undo and is dimmed.

Overstriking Text

‘There are times, however, when you want to type over exisling text. To switch to this editing
mode, press the Insert key in the keyboard. When you type, the characters you type replace
any characters to the left of the insertion point. Te tum off the overstrike mode, press the

Insert key again.

Deleting Text |
Use mouse pointer o highlight the desire text and press the Del key from the keyboard.
Insert File
1. Move mouse pointer in the location were you would tike the insertion take place.
2. From the Insert meny, select File option.

3. From the File name combination box, select the file you would like to insert.
Click the OK button.
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Creating the Header or Footer

1. From the View menu, choose Header and Footer.
2 The Header and Footer toolbar appear, click the switch between Header
and Footer button. The header and footer areas are enclosed by a nonprinting
dashed line. :
3. Do one or more of the following;
Text - You can Iype the text within the dashed line that surround the header
or footer area.
Page Number - Click the icon.
Current Date - Click the icon.
Current Time - Click the icon.
4. To return to the document, choose the Close button on the Header and Footer
toolbar, or double-click the main text arca

Previewing the Document

1. From the File menu, choose Print Preview.
While in the print preview mode, you can perform the following options.
a) You can print the document by click the Print button.

" b) You can switch the magnifier on and off by clicking on the magnifier button.
“¢) You can switch to a one page view by clicking the One Page button.
“d) You can switch to view multiple pages by clicking on the Multiple

Pages Button and dragging across the grid that appears, releasing the
" mouse button when you have the multiple-page view you waat to use.
"¢) You can zoom in or out on your document by adjusting the zoom
percentage in the Zoom Control drop-down list box.
£} You can switch the view of the ruler on and off by clicking on the
- View Ruler button. _
¢) You can squeeze a smali _amount‘of text on the final page into the
 the outer pages by clicking on the Shrink to Fit button.
'h} You can expand the preview screen to show oaly the page, the
woolbar, and the status bar clicking on the Full Screen button.
I) You can exit the preview mode by clicking on the Close button..

Printing your Docament

1. From the File menu, choose Print option.
" A Print dialog box appear. :

2. In the Print What drop-dawn list box. This option enables you to priot the
document or several items ancillary to (he document, such as Summary Info,
Annotation, Style, Autotext Entries, and Key Assignments. :

3. Use the Copies box 1o enter the number of copies to print.

4. Use the Page Range option to determine how much of the do¢ument to print.
You can print All the document, the Current Page, or selected Pages. .

5. Check the Collate Copies check box to finish the first sel of copy before
printing the second copy.

6. Whea all it set correctly, close all the dialog boxes you have open,
and click OK button, the printing process begin.
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6.1,

PW4SP DATA FILES

Data files are collection of information revelant to the preparation of PW4SP. Data files are
logically group into three major areas of information. The first group of information are the
base data that are composed of information derived from survey, ocular inspection, and
existing information from the provincial and national agencies. The second grovp of
information are the key parameter data that are composed of information derived from
applicable policies, assumption, water test result, and current cost of commodity. The third
group of informalion are the presentation of data which derived from the previously
mentioned groups of information’s, this data are processed and then logically arranged to
show provincial profile, existing facilities and service coverage, past financial performance,

future requirement of the relevant sector, cost estimates for future sector devetopment, and

firancial arrangenent.

Base Information

}. Socip-cconomic Data (socio.xls)

a)
b)
c)
d)
e)
f)
8

- Administrative Composition ({M) Administrative Composition)

Past Population ( (M) Past Population Page | t0 2)
Projected Population { (M) Projected Population)

.Household ( {M) Houschold)

Services { (M) Setvices)
Occupation ( (M) Occupaiion) _
Family Income, Education and Literacy ( (M) Family Income and Education)

2. Land Use Data (Janduse.xls)
~ a) Existing Land Use ((M) Existing Land Use)

b)

Future Land Use ((M) Futuce Land Use)

3. Health Data (health.xls)

a) Morbidity, Mortality and Infant Mortality (M) Moibidity and Morality)
b} Facility and Practitioner (M) FacilityPractitioner)

4. Water Resource Data {(h2ores xls)

a) Geaeial Information { (M) General Information)
b) Water Source Information ( (M) Source Infermation)

5. Water Supply Systems Data (h2osupp.xis)

a) Level Il Systems ((S8) Level LIEP1-2 .. P2-2)
b) Level H Systems ( {(8) Level 1 Pi-4 . P4-4)
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6.2

63,

6. Environmental Sanitation Data (sanit.x!s)

a) Household Toilets { (M) Houschold Toilets)

b) School and Public Toilets ( (M) Sch. and Pub. Toilets)
¢) Drainage Facility ( (M) Drainage Facitity}

d) Solid Waste Collection and Disposal ( (M) Solid Waste)

7. Investinent Data (invest.x|s)

a) Previous Annual Investment { (P) Fin. Past Ann. Invest.)
b) Planned Annual Investment { (P) Fin. Future Ann. Invest.)

Key Parameter

1. Key Parameters (keypar.xls)

a) Key Parameter (Key Parameter)

b) Level I - Safe and Unsa!’e {Level I Safe and Unsafe)
¢) Well Source Composmon (Well Source Composition)
d) Unit Cost (Unit Cost)

e) Scoring Factor (Scoring Factor)

f} Annaal Investinent (Annual Investment)

Data Presentation

L. Provincial Pfoﬁle {chap-3.xls)

a) Outline of City and Municipalities (MTable 3.1.1)
- b) Current Land Use (MTable 3.2.1)
-¢) Drainage Areas and Flow Rales of Major Rivers (MTable 3.2.2)
d) Distribution of Households by Income Class (MFigure 3.3.1)
e) Population Distribution by Occupation (Figure 3.3.2)
f) Population Distribution by Highest Attainment of Education (MFigure 3.3.3)
. g) Provinctal Qutline on Public Services {(MTable 3.3.1)
h) Public Facilities and Secvices by Municipality (MTable 3.3.2)
i) Previous Population Development of the Province (MFigure 3.4.1)
i) Previous Population Development by Municipality (MTable 3.4.1)
k) Present Population Distribution (MFigure 3.4.2)
1) Outline of Urban and Rural Areas in the Province (MTable 3.4.2)
m) Household Numbers and Household Sizes (MTable 3.4.3)
n) Number and Rates of Ten Leading Causes of Morbidity,
"~ Mortatity and Infant Montality (MTable 3.5.1) '
0) Reported Cases arid Deaths of Notifiable Water Related Diseases (MTable 3.5.2)
p) Municipal Solid Waste Collection and Disposal, and
Service Coverage in 1994 (MTable 3.6.1)
q) Number and Ratio of Population to Heallh Facilities
andfor Medical Practitioners (STable 3.5.1)
t) Types of Drainage Facilities (STable 3.6.1)
s) DENR Water Quality Criterit/Water Usage and Cl.l\\lflc.lllf)n
for Fresh Water (STable 3.6.2)

2. Existing Facilities and Service Coverage (chap-4.x1s)

a} Information on Existing Level ITT Systems (MTable 4.1.2)
b) Information on Water District (MTable 4.1.3)
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¢) Information on Existing Level Il Systems (MTable 4.1.4)
d) Information on Existing Level I Facilitics {MTable 4.1.5)
&) Water Supply Service Coverage by Municipality in 1994 (MTable 4.1.7)
f) Water Supply Service Coverage by Municipality (MFigure 4.1.1)
g) Sanitation Facilities and Service of Household Toilets, Urban and
Rural, 1994 (MTable 4.2.1)
h) Provincial Service Coverage of Household Toilet Facilities, 1994 (MFigure 4.2.1)
i) School Toeilet Facilities and Service Coverage in 1994 (MTable 4.2.2)
1) Public Toilet Facilities and Service Coverage in 1994 (MTable 4.2.3)
k) Details on Existing Level 111 Systems (STable 4.1.1 Sheet | 10 4)
1) Details on Existing Level Il System {(STable 4.1.2 Sheet 1 t0 6)
m) Number of Level I Facilities by Safe and Unsafe Classification (STable 4.1.4)
n) Estimation of Unserved Population by Municipality (STable 4.1.5)
o) Estimation of Population Covered by Safe and Unsafe Source
by Municipality (STable 4.1.6 Sheet ! to 2)
p) Sanitation Facilities and Service Coverage of Houschold Toilets
by Type, by Municipality, Urban and Rural, 1994 {STable 4.2.1)

3) Past Financial Performance in Water Supply and Sanitation (chap-6.x1s)

a) Previous Sector Investment to the Province by Concerned Agency (MTable 6.2.1)
b) Past Internal Allotment to the Province from Central Government (MTable 6.2.2)
-¢Y Affordabikity in Water and Sanitation Services (MTable 6.4.1)
d) Financial Indicators of Water Districts {(MTable 6.5.1)
¢) Loan Status of Water Districts (MTable 6.5.2)
f) Past Internal Revenue Allotment to Municipalities from
Central Government{STable 6.2.1) . o §

4 Waier Source Development (chap-?‘_xls)

- a) Existing Groundwater Sources in the Province (MTable 7.1.1)
b) Work Flow of Groundwater Availability Map (SFigure 7.3.1)
¢) Existing Spring Sources by Municipality ($Table 7.4.1)

d) River Information and Related Data (STable 7.5.1)

¢) Water Quality Analysis Results {(STable 7.5.2)

f) Existing Well Sources (STable 7.6.1)

g) Standard Specification of Wells by Mumc:pahly (STabIe 7.6.2)

5) Future Requirement in Water Supply and Sanitation Environment (chap-8.xls)

1) Provincial Sector Targets (MTable 8.2.1)
2) Base Year Service Coverage of Water Supply (MT.:b!e 8.2.2)
3) Base Year Service Coverage of Household Toilets (MTable 8.2.3)
4) Base Year Service Coverage of Public School Toilets and

Public Toilets (MTable 8. 2 4)
5) Base Year Service Coverage of Municipal Solid Waste System in 1994 {‘V!Tab!c: §.2. 3
6) Future Population by Urban and Rural Area by Municipality (MTable 8.3.1)
7) Projected Public School Enrollment and Number of Public Utility

by Municipality (MTable 8.3.2)
8) Population to be Served by Target Year (Water Supply) (MTable 8.5.1) g
9) Additional Number of Households to be Served by Target Year

(Household Toilets) (MTable 8.5.2)
10} Additional Number of Public Schoo! Student to be Secved by

Target Year (Schoo! Toilets) (MTable §.5.3)
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11) Additional Number of Public Utilities with Sanitary Toilets
by Target Year (MTable 8.5.4)
12) Population to be Served by Urban Sewerage in Phase I1 (MTable 8.5.3)
13) Additional Number of Urban Households to be Served by
Municipal Solid Waste System in Phase 1 {MTable 8.5.6)
14) Water Supply Facilities Required by Target Year (MTable 8.6.1)
15) Sanitation Facilities Required by Target Year (MTable 8.6.2)
16) Number of Garbage Collection Trucks Required in Phase I (MTable 8.6.3)
17) Estimation of Base Year Service Coverage of Water Supply (STable 8.2.1)
18) Popuhuon Coverage in Phase I Provided by Served Population
in the Base Year (STable 8.2.2)
19) Number of Households Served by Sanitary Toilets in the
Base Year (1994)(5Table §.2.3)
20) Nuinber of Public Schoo! Student Served by School Toilets in the
Base Year {STable 8.2.4)
21) Numnber of Public Utilities with Sanitary Toilets in the
Base Year (1994) (STable 8.2.5)
22) Households Coverage in Phase [ Provided by Existing Facilities in the
Base Year {(Household Toilets) (STable 8.2.6) '
23) Public School and Public Coverage in Phase I Provided by
Existing Facilities in the Base Year (STable 8.2.7) '
24) Projected Number of Households by Urban and Rural Areas by
~ Municipality by Target Year {STable 8.3.5)
25) Projected School Enrollment by Municipality by Target Year (STable 3.3.6)
26) Projected Number of Public Utilities by Municipality by Target Year (STable 8. 3 7)
27) Population (o be Served by Level H System in Phase [(STable 8.5.1)
28) Population to be Served in Phase 1 {(Water Supply) (STable 8.5.2)
29) Population to be Served in Phase 11 (Water Supply) {STable 8.5.3)
30} Additional Number of Households (o be Served in
Phase I {Housechold Toilets) (STable 8.5.4)
31) Additional Number of Households to be Served in
Phase 11 (Household Toilets) (STable 8.5.5)

. 32) Additional Number of Public School Students to be Served in

Phase I and 1l (School Toileis) (STable 8.5.6)

- 33) Additional Number of Public Utilities with Sanitary Toilets in”

Phase Land 11 (STable 8.5.7)
34) Urban Water Supply Facilities Required by Target Year (STable 8.6.1)
35) Plan for Expanston of Existing Level HI System (STable 8.6.2)
36) Rural Water Supply Facilities Required by Target Year (STable 8.6.3)

© 37) Urban Houschold Toilets Required by Target Year (STable 8.6.4)
© 38) Rural Household Toilet Required by Target Year (STable 8.6.3)

39) Pﬂhii; School Toilets Required by Target Year ($STable §.6.0)
40) Public Toilets Required by Target Year (STable 8.6.7)

6) Cost Estimates for Future Sector Development (chap- 10.x1s)

a) Unit Cost of Facilities by Type and Service Level (MTable 10.2.1}

b) Construction Cost of Required Facilities by Municipality {(MTable 10.3.1)
¢) Recurcent Cost (MTable 10.4.1)

d) Unit Cost of Level I (Deep Well - 40 meter Depth) (STable 10.2.1)

¢) Unit Cost of Levet 1 (Deep Well - 80 meter Depth {STable 10.2.2)

f) Unit Cost of Level E{Deep Well - 120 meter Depth) (STable 10.2.3)

g) Unit Cost of Levei I {Deep Well Rehabilitation) (STable 10.2.4)

h} Unit Cost of Level I {Shallow Well - {8 meter Depth) (STable | 10.2, i)

- 127



i) Unit Cost of Level TT (600 Service Population) (STable 10.2.6)
j) Unit Cost of Level I11 (5,000 Service Population) (STable 10.2.7)
k) Unit Cost of Level 111 (10,000 Service Population) (STable 10.2.8)
) Unit Cost of Level I11 (15,000 Service Population) (STable 10.2.9)
m) Unit Cost of Flush Water Sealed with Septic Tank Toilet (STable 10.2.10)
1) Unit Cost of Pour Flush with Double Pit Latrine (STable 10.2.11)
0) Unit Cost of Ventilated Improved Pit Latrine (STable 10..2.12}

p) Unit Cost of School Toilet (STable 10.2.13)
q) Unit Cost of Public Toilet (STable 10.2.14}
£) Construction Cost of Water Supply Facilities Required for

Phase I (2000) (STable 10.3.1)
$) Construction Cost of Water Supply Facilities Required for

Phase I (2010) (STable 10.3.2)

t) Cost of Sanitation Facilities Required for Phase 1 {2000) (STable 10.3.3)
u) Cost of Sanitation Facilities Required for Phase 11 (2010} (STable 10. 3.4)

) Financial Arrangemeants {chap-11.xls)

a) Projected Intemal Revenue Allotment for Medium-Tenmn
Sector Development (MTable 11.2.4}
b) Projected Allotment of IRA to the Relevant Sector by
Componen, 1996-2000 (MTable 11.2.2)
¢) Financing Reguirements by Sector Component for the Province (M Fabie 11.3.1)
~ d) Additional Fund Requirement for Medivmn-Term Plan (MTable 11.3.2)
e) Internal Revenue Alotment for Water Supply and Sanitation Sector
by Municipality (Medium-Term Development 1996-2000} (MTable 11.3.3)
f) Relationship between Funding Levels and Percent of Coverage
for Water Supply Sector (MFigure 11.4.1)
g) Relationship between Funding Levels and Percent of Coverage
for Sanitation Sector (MFigure 11.4.2)
h) Municipal Investment Need Ranking for Urban Water Supply (MTabic 11.4.1)
") Distribution of Provincial IRA to Municipality for
Urban Water Supply (MTable 11.4.2)
i) Municipat Investment Need Ranking {(MTable 11.4.3)
k) Percentages for Annual Investment {STable 11.3.1) :
1} Comprehensive Investment Need R'mkmg of the Munlc1pahltes (STable (1.4.1)

 DATA FILES LINKAGES

Linkéges are logical connection between records in the data files. Through linkages, once the
user's updates the source data, all data in the streams of linkages are dynamically updated.
Linkages are the convenient tools of updating related data, these also shield the user’s from
the complexity of formula manipulation. With the aid of the data linkages the vser's can

concentrate more in validating the source data.

The following table lists the logical connections for each worksheet.
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8.1.

UPDATING PWA4SP DATA BASE

The following procedures are guide in updating the base data of the PWA4SP data

management system. The word celumn and row in this procedure mean the internal column

and row notation in the worksheet environment.

Updating Socio-economic Data Base

1. Click the File menu, select Qpen.
Short-cul: Click the Open butlon.
2. From the Open Dialeg Box. Select the secio.xls filepame.,
3.1 To update the Administrative Composition Data,
click the tab of (M} Area and Population sheet.

NEDA geopgraphic code: move mouse pointer to column A. Starting at the row
below the column description, select the data you would like to update and type the
new value,

Municipal Name: move mouse pointer to column B. Stadding al the row below the
column description, in reference to column A (NEDA geographic code) select the
data you would like to update and type the new value.

City: move mouse pointer to column C. Starting at the row below the column

+ description, in reference to column B (name of municipality) select the data you

would like to update and type the new value.

Municipal: move mouse pointer to column D. Starting at the row below the column
description, in reference to column B {(name of municipality) select the data you

“would like to update and type the new value,

Class: move mouse pointer to column E. Starting at the row below the column

'_desctip!ion. in reference to column B (name of municipality) select the data you
would like to update and type the new value.

Urban Barangay: move mouse pointer to column J. Starting at the row below the
column description, in reference 0 column B (name of municipality) select the data
you would like to update and type the rew value.

Rural Barangay: move mouse pointer to column K. Starting at the row below the
column description, in reference to column B (name of municipality) select the data
you would like to update and type the new value.

3.2 To update the Past Population Data,’
click the tab of (M) Past Population Page [ sheet.

1903: move mouse pointer to column D. Starting at the row below the column
description, in reference to column B (name of municipality) select the data you
would like to update and type the new value.

1918: move mouse pointer to column E. Starting at the row below the column
description, in refecence to column B (name of municipality) select the data you
wauld like to update and type the new value.,
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1939: move mouse pointer to column F. Stating at the row below the column
description, in reference 1o column B (name of municipality} select the data you
would like to update and type the new value.

1948: move mouse pointer to column G. Starting at the row below the column
description, in reference to column B (name of mwnicipality) select the data you
would like to update and type the new value.

1960: move mouse pointer to column H. Starting at the row below the column
description, in reference to column B {name of municipality) select the data you
wauld tike to update and type the new value.

1970: move mouse pointer to column [. Starting at the row below the colamn
description, in reference to column B (name of municipality) select the data you
would like to update and type the new value,

I1975: move mouse pointer to column J. Starting at the row below the column
description, in reference to column B (name of municipality) select the data you
would like to update and type the new value.

click the tab of (M) Past Popitlation Page 2 sheet.

“Urban Popualation (1980): move mouse pointer to column D. Starting at the row
- below the column description, in reference to column B {(name of municipality) select

the data you would like to update and type the new value,

Rural Population (1980). move mouse pointer to column E. Starting at the row
below the column description, in reference to column B (name of municipality) select
the data you would like to update and type the new value. :

Urban Population (1990): move mouse pointer to column G. Starting at the row
betow the column description; in reference to column B (name of municipality) select
the data you would like to update and type the new value. -

Rural Poprdatmn {1990): wove mouse pointer to column H. Starting at the row

below the column description, tn reference to column B (name of mummpaluy) select
the data you would like to update and lype the new value. :

Urban Populationt (1994): move mouse pointer to column k. Starting at the row
befow the column description, in reference to column B {name of municipality) select

_ the data you would like to update and type the new value.

Rural Population (1994): move mouse pointer o column . Starting at the row below
the column description, in reference to column B (name of municipality) select the
data you would like to update and type the new value,

3.3 To update the Population Projection Data,

click the 1ab of (M) Project Population sheet.

‘e

Urban Population (2096): move mouse pointer to colurin [ Starting at the row
below the cotumn description, in reference to column B {name of municipality) select.
the data you would like to update and type the new value.

Rural Pepulation (2000): move mouse pointer to column K. Starting at the row

~ below the column description, in refesence to column B (namie of municipolity) select

the data you would like to update and type the new value.
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s Urban Population (2010): move mouse pointer to column S. Starting at the row
below the column description, in reference to column B (name of municipality) select
the data you would like to update and type the new value. %

¢ Rural Population (2010). move mouse pointer to column U. Starting at the row
below the column description, in reference to column B (name of municipalily) select
the data you would like to update and type the new value.

3.4 To update the Household Data,
" chick the tab of (M) Houseliold sheet.

¢ Urban Household (1980). move mouse pointer to column D. Starting at the row
below the column description, in reference to column B (name of municipality) select
the data you would like to update and type the new value.

o Rural Household (1980): move mousc poinler to column E. Stadting at the row
below the column description, in reference to column B (name of municipality) select
the data you would like to update and type the new value.

s Urban Household {1990): move mouse pointer to column G. Starting at the row
below the column description, in reference to column B (name of municipality) select
the data you would like to update and type the new valuve.

¢ Rural Household (1990): move mouse pointer to column H. Starting at the row
below the column deseciption, in reference to colurn B (name of municipality) select
the data you would like to update and type the neiv value.

o Urban Household (1994} move mwouse pointer to column J. Starling at the raw @
below the column description, in reference to coluinn B (rame of municipality) select
the data you would like to update and type the new vaiue.

®  Rural Household (I994): move mouse pointer to column K. Slarting at the row
below the column description, in reference to column B (name of municipality} select
the data you would like to update and type the new value.

3.5 To update the Services Data,
click the tab of (M) Services sheet.

s Number of Public Elementary Scheo!: move mouse pointer to column F. Starting at
the row below the column description, in reference to column B (name of
-municipality) select the data you would like to update and type the new value.

o Number of Private Elementary School: move mouse pointer to column G. Starting .
at the row below the column description, in reference to column B (name of
municipality) select the data you would like to update and type the new value.

o Number of Public High School: move mouse pointer to column L. Starting at the ow
below the column description, in refecence to column B (name of municipality) select
the data you would like to update and type the new value.

o Number of Private High Schoel: move mouse pointer to column 1. Starting at the
row below the column desceiption, in reference to column B {name of municipality)
select the data you would like to update and type the new value, %%

»  Nunmber of Colleges: move mouse pointer to column L. Starting at the row below the
column description, in reference to column B (name of municipality) sefect the data
you would like to update and type the new valus.
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e  Number of Hospitals: move mouse pointer to column M. Starling at the row below
the column description, in refecence to column B (name of municipality) select the
data you would like to update and type the new value.

o Number of Markels: move mouse pointer to column N. Starting at the row below
the column description, in reference to column B (name of municipality) select the
data you would like to update and type the new value.

o Number of Banks: move mouse pointer to columin O. Starting at the row below the
column deseription, in reference to column B (name of municipality) select the data
you would like to update and type the new valve.

3.6 To update the Occupation Data,
click the tab of (M) Occapation sheet.

o  Number of Professional,Technical and Related Workers: move mouse pointer to
column D. Starting al the row below the column description, in reference to column
B (name of municipality) select the data you would like to update and type the new
value.

o Number of Administrativé, Execulive and Managerial: move mouse pointer (o
column E. Starting at the row below the column description, in reference to colusinn B
(name of municipality) select the data’ you would like to update and type the new
value.

. o Number of Sales Workers: move mouse pointer to column F. Starting at the row
below the column description, in reference to columa B (name of municipality) select
the data you would like to update and type the new value.

o Number of Service Workers: move mouse pointer to column G. Starting at the row
below the column deseriplion, in reference to columin B (name of municipality) select
the data you would like to update and type the new value.

e Number of Agricultural, Animal Husbandry & Forestry Workers, Fisherman and
Hunetrs, move mouse pointer to column H. Starting at: the row below the column
description, in reference to columa B (name of muaicipality) select the data you
would like to update and type the new value. :

"o Number of Preduction & Related Workers, Transportation Equipment Operators

and Laborers: move mwouse pointer to column 1. Starting at the row below the

~ column description, in reference to colunin B (name of municipality) select the data
you would like to update and type the new value.

e Number of Occupation Not Adcqua(e(y Defined or Reported: move mause pointer

_to column J. Starting at the row below the column desceiption, in reference to ¢olumn

B (name of municipalily) select the data you would like to update and 1ype the new
value. '

3.7 To update the Family lnconie, Education and Literacy Data,
click the tab of (M) Family Income and Education sheet.

s Number of Family Receiving Under P 13,999; move mouse pointer to colurnn D.
Starting at the row below the column description, in reference to column B {name of
municipality) select the data you would like to update and type the new value.

o Number of Family Receiving Between P 15,000 to £ 29,999: move mouse pointer
to column E. Staing at the row below the column description, in reference (o
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column B (name of municipality) select the data you would like to update and type
the new value.

Number of Family Receiving Between P 30,000 to P 39,999: move mouse pointer
to column F. Starting at the row below the column description, in reference to
column B (name of municipality) select the data you would like to update and type
the new value,

Number of Family Receiving Belween P 40,000 to £ 59,999. move mouse pointer
to column G. Starting at the row below the column description, in reference to
column B {(pame of municipality) select the data you would like to update and type
the niew value.

Nuinber of Family Receiving over £ 60,000: move mouse pointer to colamn H.

Starting at the row below the column description, in reference to column B (name of

municipality) select the data you would like to update and type the new value.

Number of Population that Finish Pre-School: move mouse pointer to column L
Starting at the row below the column description, in refecence to column B (name of
municipality) select the data you would like to update and type the new value.

Number of Population that Finiskh Efententary Scheel. move mouse pointer Lo

column J. Starting at the row below the column description, in reference to column B
(name of municipality} select the data you would like to update and type the new
value.

Numnber of Population that Finish High School: move mouse pointer to column K.
S!artmg at the row below the column description, in reference to column B {(nameé of
municipality) select the data you would like to update and type the new value.

Number of Population that Finish College and Post Graduate, move mouse poinler
to column L. Starting at the:-row below the column description, in reference to
column B (name of municipality) select the data you would like to update and type
the new value.

Number of Literate Population: move mouse pointer to column M. Starting at the
row below the column description, in reference to column B (name of mumcupahty)
select the data you would like to update and type the new value.

Number of Hliterate Population: move mouse pointer o column N. Starting at the
row below the columin description, in reference to column B {name of municipality)

select the data you would like to update and type the new value.

Updating Land Use Data Base

{. Click the File menu, select Open.
Short-cut: Click the Open button.
2. From the Open Dialog Box. Select the landuse. xls filename.
3.1 To update the Existing Land Use Data,
click the tab of (M) Existing Land Use sheet,

L]

Forest Land Area: move mouse pointer to column C. Starting at the row below the
column description, in reference to columa B (same of municipality) select the data
you would like to update and type the new value,
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o Grass Land Area: move mouse pointer to columin D. Starting at the row below the
column description, in ceference to column B (name of municipality} select the daia
you would like to update and type the new value.

o  Built-up Land Area: move mouse pointer to column E. Starting at the row below the
column description, in reference to column B (name of municipality} select the data
you would like to vpdate and type the new value.

o Agricultural Land Area: move mouse pointer to column F. Starting at the row below
the column description, in reference (o column B (name of municipality) select the
data you would like to update and type the new value.

o Mangrove, Fishponds, In-land Area: move mouse pointer to column G. Staiting at
the row below the column description, in reference to column B (name of
municipality) select the data you would like to update and type the new value.

o Open Land Area: move mouse pointer to column H. Starting at the row below the
column description, in reference to column B (name of municipality) select the data
you would like to update and type the new value.

3.2 To update the Future Land Use Data,
click the tab of (Af) Future Land Use sheet.

¢ - Forest Land Area: move mouse pointer (o cdlumli C. Starting at the row below the
column description, in reference to column B (name of municipality) select the data
you would like to update and type the new value. '

o  Grass Land Aréa: move mouse pointer to column ). Starting at the row below the
column description, in reference to column B (name of municipality) select the data
you would like to update and type the new value.

+ Built-up Land Area: move mouse pointer to column E. Starting at the row below the
column description, in reference to column B (name of municipality} select the data
you would like to update and type the new value.

o - Agricultural Land Area: move mouse pointer to column F. Starting at the row below
: the column description, in reference to column B (name of municipality) select the
data you would like to update and type the new value.

o Mangrove, Fishponds, fn-land Area: move mouse pointer to column G. Starting at
the row below the column description, in reference to columa B {name of
municipality) select the data you would like to update and type the new value.

o Open Land Area: move mouse pointer to column H. Starting at the row below the
column description, in reference to column B (name of municipality) select the data
you would like to update and type the new value. - : '

Updating Health Dala Base

1. Click the File menu, select Open.
Short-cut: Click the Open button.
2. From the Open Dialog Box. Select the health.xls filename. .
3.1 To update the Morbidity, Mortality and Infant Mortality Data,
ctick the tab of (M) Morbidity and Mortality sheel.
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Number of Morbidity Case: move mouse pointer to column E. Starting at the row
below the colunin description, in reference to column C {name of diseases) select the
data you would like to update and type the new value,

Number of Mortality Case: move mouse pointer to column F. Starting at the cow
below the column description, in reference to column C (name of diseases) select the
data you would like to update and type the new value.

Number of Infant Mortality Case: move mouse pointer to column G. Starting at the
row betow the column description, in reference to column C {name of diseases)
select the data you would like 1o update and type the new value.

3.2 To update the Facility and Practitioner Data
click the tab of (M) Facility and Practitioner sheel.

s Number of Hospital Facility: move mouse pointer to column D. Starting at the ow

below the column description, in reference to column B (name of municipality) select
the data you would like to update and type the new value.

Number of Rural Health Unit (RHY}: move mouse pointer to columb E. Starting at
the row below the column description, in reference to column B (name of
municipality) select the data you would like to update and type the new value.

Nuinber of Bamngdy Health Station {BHS): move mouse pointer to column F.
Starting at the row below the column description, in reference to column B {name of
municipality) select the data you would like to update and type the new value.

Number of - Practicing Doctors: move mouse pointer to column H. Stariing at the

row below the column description, in reference to column B (name of municipality)
select the data you would like to update and type the new value.

Number of Practicing Nurses: move mouse pointer to column 1. Starting at the row -
betow the column description, in reference ta column B (name of municipality) select
- the data you would like to update and type the new value. '

Number of Practicing Midwives: move mouse pointer to column J. Starting at the

row below the columin description, in reference to column B (name of niunicipality)

select the data you would like to update and type the new value.

Number of Practicing Dentists: move mouse pointer to column K. Statting at the
row below the columin descriplion, in reference to caluma B (name of municipality)
select the data you would hike to update and type the new value.

Updating Water Resources Data Base

1. Click the File menu, select Opea.

Short-cut: Click the Open button.

~ 2. From the Open Dialog Box. Select the h20-res.xls filename.

3. To update the General Information Data,
click the tab of (Af) General fuformation sheet.

Number of Shallow (Geueral Information): move mouse pointer to colunmin E/H.
Starting at the row below the column description, in reference to column C
(description of information) select the data you would like to update and type the
new value.
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8.5.

¢ Number of Deep Well (General linformation): move mouse pointer to column FfI,
Starting at the row below the column description, in reference to column C
(description of informalion) select the data you would like to updote and type the
new value.

s Number of spring (General Information): move mouse pointer to column G/1.
Stating at the row below the column description, in reference to column €
(description of information) select the data you would like te update and type the
new value.

Note: To add succeeding municipality. Copy (M) General Information sheet and
erase the default dala and type the new data following the aforementioned
procedures. '

Updating Water Supply Data Base

1. Click the File menu, select Open.
Short-cut: Click the Open buiton.
2. From the Open Dialog Box. Select the h2osupp.xis filename.
3.1 To update the Level I1I Sysiem Data,
click the tab of (S) Level 11 P1-4 sheet.

¢ Data: move 1house pointer o column G.Starting at the row below the column
description, in reference to column B (Info Description) select the data you \l.ould
‘like to vpdate and lypc the new data.

- click the tab of (S) Level _HI P2-4 sheet..
- .o Data. move mouse pmnler to column G.Starting at’ the row below the column

description, in reference to column B {Info Description) select the data you would
: like to update and type the new data. :

click the tab of (S} Level HI P3-4 sheet,
e Data: move mouse pointer to column G.Starting at the row below the columa

description, in reference to column B (Info Description) select the data you would
like to update and type the new data. '

 click the tab of (S) Level H{ P4- sheet.
s+ Data: move mouse pomter to column G.Starting at the row below the ‘column

description, in reference to column B ([nfo Description) select the data you would
like to update and type the new data.

3.2 To update the Level Il System Data,
click the tab of (8) Level I PI-2 sheet,

o Data: move mouse pointer to column G.Starting at the cow below the column
description, in reference to column B (Info Description) select the data you would
like 10 update and type the new data.
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click the tab of (8) Level If P2-2 sheet.

Data: move mouse pointer to colomn G.Starting at the row below the column
description, in reference to column B (Info Description) select the data you would
tike to update and type the new data.

3.3 To update the Level I Facility Data,
click the tab of (F) Level I sheet.

Public Facility:

Deep Well: move mouse pointer to column E. Starting at the row below the column
description, in reference to column B (name of municipality) select the dala you
would like to update and type the new value.

Shallow Well: move mouse pointer to column F. Staiting at the row below the
column description, in reference to column B (name of municipality) select the data
you would like to update and type the new value.

C‘overed/lmprmed Dug Well: move mouse pointer to column G. Starting at the row

- below the columm description, in reference to column B (name of municipality) select

the data you would like to update and type the new value.

* Open Dug Well: move mouse pointer to column H. Starting at the row below the

column description, in reference to column B (name of municipality) select the data
you would like to update and type the new value.

| Devc!aped Sprmg move mouse pointer 1o column 1. Starting at the row below the

column description, in reference to column B (name of mumc:pdllty) select the data
you would like to update and type the new value.

Undeveloped Spring: move mouse pointer to column 1. Starting at the row below the
column description, in reference to column B (name of mumnicipality) select the data

- you would like to update and type the new value,

Private Facility:

Deep Well: move mouse pointer to column L. Stasting at the row below the column
description, in reference to column B (name of municipalily) select the data you
would like to update and type the new value.

Shalfow Well: move mouse pointer to column M. Starting at the row below the

“column description, in refecence to column B (name of municipality) select the data

you would like to update and type the new value.

Covercd/lmproved Dug Well: move mouse pointer to columin N. Staiting at the row
below the cotumn desceiption, in reference to colvmn B (name of municipality) select
the data you would like to update and type the new value.

Open Dug Well: move wouse pointer to columin Q. Starting at the row below the
coluimn description, in reference to column B (name of municipality) select the data
you would like to update and type the new value.
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e Rain Collector: move mouse pointer to column P. Starting at the row below the
column description, in reference to column B (name of municipality) select the data
you would like to update and type the new value.

Updating Envivonmental Sanitation Data base

1. Click the File menu, select Open:
- Short-cut: Click the Open button.
2. From the Open Dialog Box. Select the sanit.xls filename.
3.1 To update the Household Toilet Data,
click the tab of (M) Household Toilets sheet,

o Number of Urban Houscholds Using Water Sealed Flush Toilet: move mouse
pointer to column C. Starting at the row below the column description, in reference
to column B (name of municipality) select the data you would like to update and type
the new value.

»  Number of Rural Households Using Water Sealed Flush Toilel: move mouse
pointer to column D. Starting at the row below the calumn description, in reference
to column B (name of municipality) select the data you would like to update and type
the new value.

s Number of Urban Households Using Water Sealed Pour Flush Toilet: move mouse

pointer to colurin E. Starting at the row below the column description, in reference to

_ column B (name of municipality) select the data you would like to update and type
the new value. '

o Number of Rural Households Using Water Sealed Pour Flush Toilel. move mouse
. pointer to column F. Starting at the row below the column description, in refererice to
column B (name of municipality) select the data you would like to update and type

* the new value.

o - Number of Urban Households Using VIP Latrine Toilet: move mouse pointer to

~ column G. Starting at the row below the column description, in reference to column

B (name of municipality) select the data you would like to update and type the new
 value. '

o  Number of Rural Houseliolds Using VIP iﬂ_(fi:te Toilet: move mouse pointer 1o

. column H. Starting at the row below the column description, in reference to column

B (name of municipality) select the data you would like 1o update and type the new
value.

o Number of Urban Households Using Unsanitary Toilel: move mouse pointer to .
column K. Starting at the row below the column description, in reference to column
"B (name of municipality) select the data you would like te update and tlype the new
value. o

o Number of Rural Houseliolds Using Unsanitary Toilet: move mouse pointer (0
column L. Starling at the row below the column description, in refereace (o colomn B
(name of municipality) select the data you would like to update and type the new
value.

o  Number of Urban Households Without Toilet: move mouse pointer (o column N.
Starting at the row below the column description, in reference (o column B (name of
municipality) select the data you would like to update and type the new value.
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*  Nwumber of Rural Households Without Toilet: move mouse pointer to column O.
Starting at the row below the column description, in reference to column B (name of
municipatity) select the data you would like to update and type the new value.

click the tab of (M) School Toilels sheet,

o  Numnber of Public Schiool: move mouse pointer to column C. Starting at the row
below the colunn description, in referénce to column B (name of municipality) select
the data you would like to update and type the new value.

e Number of Private School: move mouse pointer to column D. Starting al the row
below the column description, in refcrence to column B {name of municipality) select
the data you would like to update and type the new value.

o Number of Student in Public School: move mouse pointer to column F. Statting at
the row below the column description, in reference to column' B (name of
municipalily) select the data you would like to update and type the new value.

o Number of Student in Private School: move mouse pointer to column G. Starting at
the row below the column description, in reference to colunin B (name of
municipality) select the data you would like to update and type the new value.

s Number of Sanitary Toilets in Public School: move mouse pointer 1o column 1.
Starting at the row below the column description, in reference to column B (name of
nunicipality) select the data you would like to update and type the new value.

o Nuimber of Sanitary Toilets in Private Schoof: move mouse pointer to column J.
Starting at the row below the column description, in reference to column B (name of
nwnicipality) select the data you would like to update and type the new value.

e Number of Unsanitary Toilets in Public School: move mouse pomler to cotumn L.
Starting al the row below the column description, in reférence to column B (name of
raunicipality) select the data you would like to update and type the new value.

o - Number of Unsanitary Toilets in Private School: move mouse pointer to column M.
Starting at the row below the column description, in reference to column B (name of
municipality) select the data you would like to update and type the new value,

click the tab of (M) Public Toilets shect.

o Number of Public Markets: move mouse pointer to column C. Starting at the row
~ below the column description, in reference to column B (name of municipality) select
the data you would like to update and type the new value.

o . Number of Sanitary Toilets in Public Markeis: move mouse pointer 1o column D.
* Starting at the row below the column description, in reference to column B (name of
municipality) select the data you would like to update and type the new value.

o Number of Unsanitary Toilets in Public Markels: move mouse pointer te column E.
Starting at the row below the column description, in reference to column B (name of
municipality) select the data you would like to update and type the new value.

o - Number of Jeepney/Bus Terminals: move mouse pointer to column G. Starting at
the row below the columin description, in reference to column B (name of
municipality} select the data you would like to update and type the new value.
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Number of Sanitary Toilets in Jeepney/Bus Terminal: move mouse pointer to
column H. Starting at the row below the column description, in reference to column
B {name of municipality) select the data you would like to update and type the new
value,

Number of Unsanitary Toilets in Jeepney/Bus Terminal: move mouse pointer to
column 1. Starting at the row below the column description, in reference to column B
(name of municipality) select the data you would like to update and type the new
value.

Number of Parks/Playground: move mouse pointer to column K. Starting at the row
below the column description, in reference to column B (rame of municipality} select
the data you would like to update and type the new value.

Numbér of Sanitary Toilets in Parks/Playground: move mouse pointer te column L.
Starting at the row below the column description, in reference to column B (name of
municipality) select the data you would like to update and type the new value.

Number of Unsanitary Toilets in Parks/Playground: move mouse pointer to column
M. Starting at (he row below the column description, in reference to column B (name
of municipality) select the data you would like to update and type the new value.

click the tab of (M) Drainage Facility sheet.

Length of Drairiage Main: move mouse pointer to column C. Starting at the row

~ below the column description, in reference to column B (name of municipality) select

the data you would like to update and type the new value.

. Length of Open Channel (with concrete and migsonry). move niouse pointer to

column D. Starting at the row below the column description, in reference to column
B (name of municipality) select the data you would like to update and type the new
value. -

Length of Open Ditches And Unlined Laterals: move mouse pointer to column E.
Starting at the cow below the column description, in reference to'column B {name of

- municipality) select the data you would like to update and type the new value.

Length of Reinforced Concrete Circular Pipes: move mouse pointer to column F.
Starting at the row below the column description, in reference to column B {name of
municipality) select the data you would like to update and type the new value.

Leugth of Street Gutters: move mouse pointer to column G. Starting at the row
below the cofumn description, in reference to colunin B (name of municipality) select
the data you would like to update and type the new value.

Length of Outfalls To Rivers From Drainage Mains: move movse pointer- to
cotumn H. Staiting at the row below the column description, in reference to column
B (naine of municipality) select the data you would like to update and type the new
value.

click the tab of (M) Solid Waste sheet.

& .

Nimber of Open Dump Trucks: move mouse pointer ta column C. Starting at the
row below the column description, in reference to column B (rame of municipality)
select the data you would like to update and Lype the new value.
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s Number of Closed Type Trucks: move mouse pointer to column D. Starting at the
row betow the column descriplion, in reference (o column B (name of municipality)
select the data you would like to update and type the new value.

o Number of Households Served By Open Dump Site: move mouse pointer to column
F. Starting at the row below the column description, in reference to colemn B (name
of municipality) select the data you would like to update and type the new value,

*  Number of Households Served By Sanitary Landfill: move mouse pointer to column
G. Starting al the row below the columa description, in reference to column B (name
of municipality} select the data you would like to update and type the new value.

s Number of Households Depending on Dumping on Land or Water: move mouse
pointer to column H. Starting at the row below the colimn description, in reference
to column B (name of municipality) select the data you would like to update and type
the new value,

o Number of Households Depending on Burying: move mouse pointer to column
Starting at the row below the column description, in reference to column B (name of
municipality) select the data you would like to update and type the new value.

s Nunmber of Households Depending on Composting: move mouse pointer to column
J. Starting at the row below the column description, in reference to column B (name
of municipality) select the data you would like to update and type the new value.

8.7.  Updating Investment Data Base

1. Click the File menu, select Opea. : @
Short-cut: Click the Open button. : :
“2. From the Open Dialog Box. Select the invest.xls ﬁ!emme
3.1 To update the Past Investment Data,
click the tab of (P) Past Invest sheet.

o Shallow Well: move mouse pointer to column C. Starting at the row below the
column déscription, in reference to column A (name of funding awency) select the
data you would like to update and type the new value.

¢ Deep Well: move mouse pointer to column D). Starting at the row below the column
description, in reference to column A {name of funding agency) select the data you
would like to update and type the new value.

o . Spring Developinent: move mouse pointer to column E. “Stasting at the row below
the column description, in reference to column A (name of funding 1g<,ncy) select the
“data you would like to update and type the new value.

o' Well Rehabilitation: move mouse pointer to column F. Starting at the row below the
‘column description, in reference to column A (nrame of funding agency) select the
data you would like to update and type the new value.

o  Rain Collector: move mouse pointer to column G. Starting at the row below the
column description, in reference to column A (name of funding agency) select the
data you would like to update and type the new value.

o Level I Systemn: move mouse pointer to column H. Stasting at the row below the %
column description, in reference to column A (name of fundiag agency) select the
data you would like to update and type the new value.
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Level HI Sysfem: move mouse pointer to column 1. Starting at the row below the
column description, in reference to column A (name of funding agency} select the
data you would like to update and type the new value.

Sewer System: mave mouse pointer to column J. Starling at the row below the
column description, in reference to column A (name of funding agency) select the
data you would like to update and type the new value.

Private Latrines: move mouse pointer to column K. Starting at the row below the
column description, in reference to column A (name of funding agency) select the
data you would like to update and type the new value.

Schoo! Toilets: move mouse pointer to column L. Starting at the row below the
column description, in reference to column A (name of funding agency) select the
data you would like to update and type the new value.

Public Toilets: move mouse pointer to column M. Starting at the row below the
column description, in reference to column A (name of funding agency) select the
data you would like to update and type the new vajue.

3.2 To update the Planned Future Investment Data
click the tab of (P) Future Invest sheet.

Project Name: move mouse pointer to column A. Staiting at the row below the
column description, type the project identification.

Type of Project: move mouse pointer to column B. Starting at the row below the
column description, in reference to column A (namie of project) type the new value.

Phase of Project: move mouse pointer to column C. Starting at the row below the
coloman description, in reference to column A {name of project) lype the new value.

Project Location: move mouse pointer to columin D. Stagting at the row below the
column description, in reference to column A (name of project) type the new value.

Implementing Agency: iove motise pointer to column E. Stating at the row below
the column description, in reference to column A {name of project) type the new
value. ' '

Start Date of Project: move mouse pointer to column F. Starting at the row below
the column description, in reference to column A (name of project) type the new
value.

Completion Date of the Project: move mouse pointer to column G. Starting at the
row below the coluinn description, in reference to column A (name of project) type
the naw value, :

Accomplishment Status (%): move mouse pointer to column H. Starting at the row
below the column description, in reference to column A (name of project) type the
new value.

Number of Household Covered by the Project: move mouse pointer o column L
Starting at the row below the column description, in reference to column A (name of
project) type the new value.

Finance Agency: move mouse pointer to column J. Starting at the row below the
column description, in reference to column A (name of project) type the new value.
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o Cost of Level [ Facility (Thousand of pesos): move mouse pointer to column K.
Starting at the row below the column description, in reference to column A (name of
project) lype the new value. %

o Cost of Level Il System {Thousand of pesos): move mouse pointer to colamn L.
Starting al the row below the column description, in reference to column A (name of
project) type the new value.

»  Cost of Level HI System (Thousand of pesos): move mouse pointer to column M.
Starting at the row below the column description, in refercnce to column A (nrame of
project) type the new value.

e Cost of Sewer System (Thousand of pesos): move mouse pointer to column N.
Starting at the row below the columa description, in reference to column A (name of
project) type the new value.

s Private Latrine (Thousand of peses): move mouse pointer to column Q. Starting at
the row below the column description, in reference to column A (name of project}
type the new value.

*  Cost School Toilets {Thousand of pesos): move mouse pointer to column P. Starting
at the row below the column description; in reference to column A (name of project)
iype the new value.

o Cost of Public Toilets (Thousand of pesos): move mouse pointer to columa Q.
Starting at the row below the column desceiption, in refetence to column A (name of
project) type the new value.

- Updaling Key Parameter Data Base ' §

1. Click the File meny, select OQpen.
Short-cut: Click the Open button.
* 2. From the Open Dialog Box. Select the keypar.xls f:lename
3. To update the Key Parameter Data,
click the tab of $Table 2.6.2 sheel.

Water Supply:
¢ Number of Household to be Served by Level 1 Facility: move mouse pointer lo
column H-Row 3. Type the new value,

o Water Consumption Rate for Level I1 System: move mouse pointer to column H-
Row 6. Type the new value. '

Saunitation:
o Standard Number of Student to be Served by a Unit of Sanitary Toilet: move mouse
pointer to column H-Row 8. Type the new value.

o Standard Number of Toilets for Public Facility: move mouse pomter to column H-
Row 9. Type the new value,

Medium-term Plan:
o Percentage of Population Covered by Urban Water Supply: move mouse pointer (o
columa H-Row 1. Type the new value.

o Percentage of Population Covered by Rural Water Supply: move mouse pointer (o
colummn H-Row 12. Type the new value,
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Percentage of Population Covered by Sanitary Toilet: move mouse pointer 1o
column H-Row 4. Type the néw value,

Percentage of Urban Household Covered by Flush Toilet: move mouse pointer. to
column H-Row 16. Type the new value.

Percentage of Urban Hotisehold Covered by Pour Flush Toilet: wmove mouse
pointer to column H-Row 17. Type the new value.

Percentage of Urban Houseliold Covered by VIP Latrine: move mouse pointer to
column H-Row 18. Type the new value.

Percentage of Rural Household Covered by Flush Toilet: move mouse pointer to
column H-Row 20. Type the new value.

Percentage of Rural Household Covered by Pour Flush Toilet: move mouse pointer
to column H-Row 21. Type the new value.

Percentage of Rural Household Covered by VIP Lalrine: move mouse pointer to
column H-Row 22. Type the new value,

Percentage of Public Student Covered by School Toilet: move wouse pointer to
column H-Row 23. Type the new value.

" Percentage of P:fbh‘c Utitity Covered by Public Toilet: move mouse 'pointer to

column H-Row 24. Type the new value.

Percentage of Popitlation Covered by Solid Waste Collection: move mouse pointer
“to column H-Row 25. Type the new value.

Long ferm Plan:

‘Percentage of Population Covered by Urban Water Supp.’v move mouse pointer o

column H-Row 27. Type the new value.

Percentage a}' Population Covered by Rural Water Supply: move mouse pomter o
column H-Row 28. 1" ype the new value.

Percentage of .Popu!alzon Covered by Savitary Toilet: move mouse pointer ©

© column H-Row 30, Type the new value.

Percentage of Urban Household Covered by Flush Toilet: move mouse pointec to
column H-Row 32. Type the new value.

Percentage of Urban Household Covered by Pour Flush Toilet: move nouse
pointer to column H-Row 33. Type the new value.

Percentage of Urban Household Covered by VIP Latrine: mave mouse pointer to
column i-Row 34, Type the new value,

Fercentage of Rural Household Covered by Flush Toilet: move mouse pointer to
column H-Row 36. Type the new value.

Percentage of Rural Hlousehold Covered by Pour Flush Toifet: move mouse pointer
to column H-Row 37. Type the new value.

Percentage of Rural Household Covered by VIP Latrine: move niouse pointer to
column H-Row 38. Type the new value.

Percentage of Public Student Covered by School Foilet: move mouse pointer 1o
column H-Row 39. Type the new value.
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Percentage of Public Ulility Covered by Public Toilet: move mouse pointer to

®
column H-Row 40. Type the new value.

»  Percentage of Population Covered by Urban Sewerage: move mouse pointer to
column H-Row 41. Type the new value.

Rehabilitation:

o Percentage of Level I Wells for Rehabilitation: move mouse pointer 1o column H-

Row 42, Type the new value,

Sector Management Cost.

o Percentage of Feasibility and Detail Design: move mouse pointer to column H-Row
44. Type the new value.

o Percentage of Consiruction Supervision: move mouse poiater to column H-Row 45,
Type the new value.

Conlingencies:

o Percentage of Physical Contingency: move mouse pointer to column H-Row 47.

Type the new value.

Percentage of Price Contingency: move mouse pointer to cotumn H-Row 48. Type
the new value. :

Community Development and Training Cast.

Percentage for Level I System: move mouse pointer to column H-Row 50. Type
the new value. '

Percentage for Level I Facih’tjr and Leve! II System: move miouse pointer to column
H-Row 51. Type the new value,

Recurrerit Cost:

Operating Cost for Level 11 System: move mouse pointer to column H-Row 52.
Type the ncw value.

Cost of Spare Peris/Equipment for Level HI System: move mouse poiater- to
column H-Row 53. Type the new value.

Cost of Spare PartsfEquipment fdr Level I System: move mouse pointer to columin
H-Row 54. Type the new value. '

Cost of Spare Par{s/Equipmenf for Level I Facility: move mouse pointer o column
H-Row 55. Type the new value.

Public School Toilet Maintenance Cost: move mouse peinter to column H-Row 56. '

Type the new value,

Public Utility Toilet Maintenance Cost: move mouse pointer to column H-Row 57.
Type thé new value.
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Allocation Factors/Percentages of IRA:

Percentage Share from Provincial IRA: move mouse pointer to column H-Row 59.
Type the new value.

Percentage Share from Municipal/Barangay IRA: move mouse pointer to colurn
H-Row 60. Type the new value.

Funding Levels/Percentages for Different F inancing Scenarios:

*

Ist Scenario: move mouse pointer to column H-Row 62. Type the new value,
2nd Scenario: move mouse pointer to colomn H-Row 63. T ype the new value.
3rd Scenario: move mouse pointer te column H-Row 64, Type the néw value,
i Scenario: move mouse pointer to column H-Row 65. Type the new value.,

5th Scenario: move mouse pointer (o column H-Row 66. Type the new value.

click the tab of STable 2.6.3 sheet:

Percentage Proportion of Water Source: move mouse pointer to column D. Starting
at the row below the column description, in reference to column A (name of

“municipality), column B (type of area), column C (type of source) select the data you

would like to update and type the new value,

* Range Depth of Well: move mouse pointer to coluran E. Starting at the row below

the column description, in reference to column A (name of municipality), column B
{type of area), column C (type of source) select the data you would like to update and

- type the new value, ; :

" Average Specific Capacity: move mouse pointer to column F. Starting at the row

below _lhe-colunm description, in reference to column A (name of municipality),
column B (type of area), column C {type of source) select the data you would like to
update and type the new value. -

click the tab of STable 2.6.5 shect.

*

Unsafe Percentage: move mouse pointer to column C. Starting at the row below the
column description, in reference to column A (name of municipality} select the data
you would like to update and type the new value. : '

click the tab of STable 2.6.6 sheet,

- Unit Constriction Cost Sfor New Level 1t Systen: for 5,000 population: move

mouse pointer to columin B-Row 7. Type the new value.

Unit Construction Cost for New Level HI System for 10,600 population: move
mouse pointer to column B-Row §. Typé the new value. :

Unit Coustruction Cost for New Level IH] Systewr for 15,000 population: move
mouse pointer to column B-Row 9. Type the new value.

Unit Construction Cost for Level Il System Expansion for 5,000 population: move
nouse pointer to column B-Row 1. Type the new value.
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s Unit Construction Cost for Level Ilf System Expansion for 10,000 population:
move mouse pointer (o column B-Row 12, Type the new value.

o Unit Constructionn Cost for Level HI Systein Expansion for 15,600 population:
move mouse pointer to column B-Row 13. Type the new value.

¢ Unit Construction Cost for Level I System: move mouse pointer to column B-Row
14. Type the new value.

o Unit Construction Cost for Level I Facility (Deep Eell - 40 meter depth): move
mouse pointer to column B-Row 16. Type the new value.

& Unit Construction Cost for Level I Facility (Deep Well - 80 meter depth}: move
~ mouse pointer to column B-Row 17. Type the new value.

s Unit Construction Cost for Level I Facility (Deep Well - 120 meter depth): move
mouse pointer to column B-Row 8. Type the new value.

o Unit Construction Cost for Level I Facility (Shallow Well}: move mouse pointer to
cotumn B-Row 19. Type the new value.

o Unit Construction Cost for Reliabilitation of Level I Facility: move mouse pointer
1o column B-Row 20. Type the new value.

s Cost for Disinfection of Level I Wells: move mouse pointer to column B-Row 21,
" Type the new value. '

o Unit Coustruction Cost for Flush Toilet: move mouse pointer to column B-Row 22,
Type the new value.

& Unit Construction Co;st for Pour Flush Teilet: move mouse pointer to column B- @
Row 23. Type the new value,

¢ Unit Construction Cost for VIP Latrine Toilet: move mouse pointer to column B-
Row 24. Type the new valuve.

« - Unit Construction Cost for School Toi!é!:_ move mouse pointer to column B-Row
25, Type the new value.

e  Unit Construction Cost for Public Toilet: move mouse pointer to column B-Row 26.
Type the new value, o

o Unit Construction Cost for Urban Sewerage: move mouse pointer o column B-Row
27. Type the new value,

click the tab of STable 2.6.4 sheet.

Urban Water Supply (Level Il System).

¢ Feasibility Study and Detail Design: move mouse pointer to Row 6. Staiting at
Column F (Year 1996) up to Column J (Year 2000) select the data you would {ike to
update and type the new value.

s Construciion and Supervision: move mouse pointer to Row 7. Starting at Column £
(Year 1996) up to Column J {Year 2000} select the data you would like to update and ,
type the new value, @

s Community Development and Training: move mouse pointer lo Row 8. Starting at
Column F (Year 1996) up to Column J {Year 2000} sclect the data you would like to
update and type the new value,
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Rural Water Supply (Level I Facility):

L4

Detail Design: move mouse pointer to Row 10. Statting at Columin F (Year 1996} up
to Column § (Year 2000) select the data you would like to update and type the new
value,

Construction and Supervision: move mouse pointer to Row 11. Starting at Column
F {Year 1996) up to Column J (Year 2000) select the data you would like to update
and type the new value,

Conununity Development and Training: move mouse pointer to Row 12. Stasting at
Column F (Year 1996) up to Column J (Year 2000} select the data you would like to
update and type the new value.

Rural Water Supply (Level Il Systent).

Detail Design: move mouse pointer to Row 14, Starting at Columin F (Year 1996) up
to Columin J (Year 2000) select the data you would like to update and type the new
value.

Consiriction and Supervision: move mouse peinter to Row 15. Starting at Column
F (Year 1996) up to Column J (Year 2000) select the data you would like to update
and type the new value.

Commtunily Development and Training: move wouse pointer to Row 16. Starting at
Column F {Year 1996) up to Column J (Year 2000) select lhe data you would like to
update and type the new value.

Sanitation:

Urban Household Toilet: move mouse pointer to Row 17. Starting at Column I
(Year 1996) up to Column 3 (Year 2000) selecl the data )ou would like to update and
type the new value.

Rural Household Tor!et move mouse pointer to Row 18. Starting at Column F

- (Year 1996) up to Column J (Year 2000) selecl the data you would like to update and

type the new value.

Public School Toilet: move mouse pointer to Row 19. Starting at Column F (Year
1996) up to Column § (Year 2000) select the data you would like to update and type

the new value,

Public Toilet: move mouse pointer to Row 20. Starting at Column F. (Year 1996) up
to Column J {Year 2000) select the data you would like to update and type the new
value.

Disinfection of Level I Wells: move mouse pointer to Row 2! Starting at Column F
{Year 1996} up to Column J (Year 2000} select the data you “would like to update and
type the new value.

Detail Design; move motse pointer to Row 22. Starting at Coluain F (Year 1996) i:p
to Column J {Year 2000} select the data you would like to update and type the new
value.

Construction and Supervision: move mouse pointer 16 Row 23, Starting at Colunm
F (Year 1996) up to Column J (Year 2000) select the data you would like to update
and type the new value.
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Community Development and Training: move mouse pointer (o Row 24, Starting at
Colurn F (Year 1996) up to Column J (Year 2000) select the data you would like to
update and type the new value.

click the tab of STable 2.6.7 & 2.6.8 sheet.

Scoring Factor for Municipal Investment Ranking for Urban Water Supply:

Minimun Percentage of Underserved and Unserved Population in Base Year: move
mouse pointer (o column B, in reference to column A (score) select the data you
would like to update and type the new value,

Maximun Percentage of Underserved and Unserved Population in Base Year: move
mouse pointer to column D, in reference to column A (score) select the data you
would like to update and type the new value.

Weight Allocation Score for Underserved and Unserved Population in Base Year:
move mouse pointer to column C-Row 9. Type the new value.

Minimun Percentage of Underserved and Unserved Population in Phase I. move
mouse pointer to column E, in reference to column A (score} select the data you
would like to update and type the new value.

Maximu Percentage of Underserved and Unserved Population in Phase I: move
mouse pointer lo column G, in reference 1o column A (score) select the data you
would like to update and type the new value..

Weight allocation Score for Underserved aiid Unserved Populmmn & Plase I: move
mouse pointer to column F-Row 9. Type the new value

Minimun Percentage of Underserved and Unserved by Lével I System in the Base
Year: move mouse painler to column H, in reference to cofumn A (score) select the

" data you would like to update and type the new value.

Maximum Percentage of of Underserved and Unserved by Level 111 System in the

- Base Year: move mouse pointer to columm J, in reference to column A (score) select

the data you would like 1o update and type the new value.

Yeight Allocation Score far.Undersen'ed and Unserved by Level I System in the

* Base Year: move mouse pointer to column I-Row 9. Type the new value.

Scoring Factor for Municipal Compreliensive Investment Ranking:

Minimun Percentage of Rural Water Supply: move mouse pointer to colurn E, in
reference to colunn A (score) at starting at row 1S, select the data you would like to
update and type the new value.

Maxinuni Percentage of Rural Water Supply: move mouse pointer to column G, in
teference to column A (score) at starting at row 15, select the data you would like to
update and type the new value.

Weight Allocation Scere for Rural Water Supply: move mouse pointer to calumn F-
Row 20. Type the new value.

Mininiun Percentage of Urban Sanitation: move mouse pointer to column H, in
reference to column A (score) at starting at row 15, select the data you would like to
update and type the new vatue.
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8.9,

89.1.

Maximum Percentage of Urban Sanitation: move mouse pointer to column J, in
reference to column A {score) at starling at row 15, select the data you would like to
update and type the new value.

Weight Allocation Score for Urban Sanitation: move mouse pointer to column -
Row 20. Type the new value.

Minimun Percentage of Rural Sanitation: move mouse pointer to column K, in
reference to column A {score) at starting at row 15, select the data you would like to
update and type the new value,

Maximum Percentage of Rural Sanitation: move mouse pointer to column M, in
reference to column A (score) at starting at row 15, select the data you would like to
update and type the new value.

Weight Allocation Score for Rural Sanitation: move mouse pointer to column L-
Row 20. Type the new value.

Updating Unit Construction Cost Dala Base .
Water Supply

1. Click the File menu, select Open.
Short-cut; Click the Ogen button.
2. From the Open Dialog Box. Select the chap-10.x!s filename.
3.1.To update the Unit Cost for Level 111 (5,000 population),
click the tab of $Table 10.2.7 sheet. '

o Quantity: move mouse pointer to column C. Starting at the row below the column

description, in reference lo columa B (item description) select the data you would
like to update and type the new value.-

~ Unit Cost: move mouse ‘_poimer to column E. Starting at the row below the column
* desceiption, in reference to column B (item description) select the data you would

like to update and type the new valie.

" 3.2To update the Unit Cost for Level IT1 (10,000 population),

click the tab of STable 10.2.8 sheet.

&  Quantity: move mouse pointer (o c_clmnn C. Starting at the tow below the column

description, in reference to column B (item description) select the data you would
like to update and type the new value,

Unit Cost: move mouse pointer to column E. Starting at the row below the column
desctiption, in reference to column B (item description) select the data you would
like to update and type the new valve.

3.3.To update the Unit Cost for Level HI (15,000 population),
click the tab of STable 10.2.9 sheei.

o Quantity: move mouse pointer to column C. Starting at the row below the columin

description, in reference to column B (item description) seleet the data you would
like to update and type the new value,
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»  Unit Cost: move mouse pointer to column E. Statting at the row below the column
description, in reference to column B (item description) select the data you would
like to update and type the new value.

3.4.To update the Unit Cost for Level 11 (600 population},
click the tab of STable 10.2.6 sheet.

o Lump Cost of Spring Box: move mouse pointer to column G-Row-4. Type the new
value.

s - Quantity of Installation of Pipelines and Fiftings: move mouse pointer to column D.
- Starting at the fow below the column description, in reference to column B (item
description) select the data you would like to update and type the new value.

*  Unit Cost of Installation of Pipelines and Fittings: move mouse pointer to column
F. Starting at the row below the column description, in reference to column B (item
description) select the data you would like to update and type the new value.

3.5.To update the Unit Cost for Level I (Dcep Well - 40 m depth),
click the tab of STable 10.2.1 sheet.

. Lump Sum Cost of Moblltzalwn/l)emobrhmlwn ‘move mouse pointer to colunn F-
Row-4. Type the new value.

*  Quantity: mave mouse pointer to column C. Staiting at the row beloiv the column
description,-in reference to column B (item descnplton) select the data you would
like to update and type the new value.

v Unit Cost: move mouse pointer to ¢olumn E. Starting at the row below the column
description, in reference to column B (item description) select the data you would
like to update and type the néw value.

3.6.To update the Unit Cost l'dr Level I {Decp Well - 80 m depth),
¢lick the tab of STahle 10.2.2 shecl.

~ e Lump Sum Cost of Mobilization/Demebilization: move mouse pointer to column F-
" Row-4. Type the new valuge,

s Quantity: move mouse pointer to column C. Starting at the row below the column
description, in reference to column B {item description) select the data you would
like to update and type the new value.

o Unit Cost: move mouse pointer to column E. Starting at the row below the column
description, in ceference to column B (item description) select the data you would
like to update and type the new value,

'3.7.To update the Unit Cost for Level I (Deep Well - 120 m depth),
click the tab of STable 10.2.3 sheet.

¢ Lump Sum Cost of Mobilization/Demobilization: move mouse pointer 10 column F-
Row-4, Type the new value.

¢ Quantity: move mouse pointer to column C. Starting at the row below the columin
description, in reference to column B (item description) select the data you would
like to update and type the new value,
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e Unit Cost: move mouse pointer to column E. Starting at the row below the column
desceiption, in reference to column B {item description) select the data you would
like to update and type the new value.

31.8.To update the Unit Cost for Level I (Deep Well Rehabititation),
click the tab of STable 10.2.4 sheet,

o Lump Sum Cost of Mobilization/Demobilization; move mouse pointer to column F-
Row-4, Type the new value.

o Quantity: move mouse pointer to column C. Starling at the row below the column
description, in reference to columna B (item description) select the data you would
like to update and type the new value.

o Unit Cost: move mouse pointer to column E. Starting at the row below the column
description, in reference to column B (item description} select the data you would
like to update and type the rew value.

3.9.To update the Unit Cost for Level (Shallow Well - 18 m depth), '
click the tab of STable 10.2.5 sheet.

o Lump Sum Cost of Mebilization/Demobilization: move mouse pointer to column F-
Row-4. Type the new value. :

‘e Quantity: move mouse pointer to cotumn C. Starting at the row below the column
" description, in reference to column B (item description) select the data you would
like to update and type the new value,

¢ Unit Cost: move mouse pointer ta column E. Starting at the row below the column
description, in reference to colurn B (item description) select the data you would
like to update and type the new value,

$92. Environmental Sanitation

1. Click the File menu, select Qpen.
Short-cut: Click the Open button.
2. From the Open Dialog Box. Select the chap-10.xds filename.
3.1.To update the Unit Cost of Flush Waler Sealed Toilet with Seplic
click the tab of STable 10.2, 10 sheet. R

e Quantity: move mouse pointer to column C. Starting at the row below the column
description, in reference to column B (item description} select the data you would
like to update and type the new value. '

e  Unit Cost: move mouse pointer to column E. Starting at the row below the column
~ description, in reference to column B (item description) sefect the data you would
like to update and type the new value.

3.2. To update the Unit Cest of Pour Flush Teilet with Double Pit Latrine
click the tab of STable 10.2.11 sheet. '

o Quantity: move mouse pointer to column C. Starting at the row below the columa
description, in reference to column B (item description) select the data you would
like to tipdate and type the new value.
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e Unit Cost: move mouse pointer to column E. Starting at the row below the column
description, in reference to column B (item description) select the data you would
like to update and type the new value.

3.3.To update the Unit Cost of Ventilated Improved Pit Latrine (VIP)
click the 1ab of STable 10.2.12 sheet.

»  Quantity: move mouse pointer to celumn D. Starting at the row below the column
description, in reference to column C (item description) select the data you would
like to update and type the new value.

o Unit Cost: move mouse pointer to column H. Starting at the row below the column
description, in reference to column C (item description) select the data you would
like to update and type the new value.

3.4.To update the Unit Cost of Schosl Toilet
click the tab of $Table 10.2.13 sheet.

s  Quantity: move mouse pointer to column D. Starting at the row below the coluinn
description, in reference to column C (item description) select the data you would
like to update and type the new value.

o Unit Cost: move mouse pointer to column H. Starting at the row below the column
- description, in reference lo column C (item description) select the data you would
- like to update and type the new value.

3.5.To update the Unit Cost of Pubtic Toilet
~ click the tab of STable 10.2.14 sheet.

e - Quantity: move mouse pointer 1o column D). Stariing at the row below the column
description, in reference to column C (item descnptlon) select the data you would
like to update and type the new value.

o Unit Cast: move mouse pointer to column H. Starting at the row below the column
description, in reference to columa C {item description) select the data you would
like to update and type the new value.

Standard Report Format

The following page describes the standard report format. Please refer to MS-Word Basic

Operation in Section 5 for procedure in selting the MS-Word environment.




Specification foxr Standard Report Format

l+————— Fdge of paper. Title of section — s
4. EXISTING FACILITIES AND SERVICE COVERAGE—"
4.1 Water Supply = — Sub-section
f Text box ———=
4.2. General —=-— ‘
- Allaround margin - 1" ———— = -

This is an example oulput of the main text.
- Spacing between paragrpak - 1 blank line.
Type and composition of water supply facilities are classified into

three service levels based on the definition given in thé National
Sector Master Plan and presented in Table 4.1.1. Various types of
Level | Facilities/sources defined to safe and unsafe sources by DOH|
This classification adopted for preparation of PW4SP does noy
disregard the facts that the existing improved/covered dug well is
sometimes yielding non-potable water.

W4+J istindeat - 0.5
(1) Peoblem areas .
I"*'*fi# 2nd indent - 0.25" _

Problem areas are identified through review of the exsiting water
supply facilities and countenmeasures and recommendations for
their improvement are prepared to reflect on the future planning in
PW4SP.

1) Level 1 facilities

Comments on each sub-title shall be followed in the manner
: Shatl

as shown hercwith. g .
‘ \t Line spacing - 1.5 line. -

. Driven shallow wells

Most  of driven shattow wells are’ ¢xposed to danger of
olution through seepage of surface water,

— 3rd indent - 0. 25"

- 4th indent - 0.25"
L

Standard sellings;

Standard Font - New Roman Tines.

Font Size - H points.

Paragraph - fustified alignment.

Title of Section - Bold Font, All Upper Case.
Sub-Section - Bold Font, First Leiter Upper Case.

-—-——— At around margin - 1"
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Key Parameter

No. Description of Key Parameter Unit Values
1. . |Woter Supply
S Number of household to be served by Level ! Facility D N 1 e
E Watzr Consumption Raie for Level 11l System therfcapatafday
2 [Sanitation
g‘ Std. number of student to be served by a unit of sanitary loitet _ SmdemvToitet
Standard nurber of toilets for a public utitity Toilet/Public Facility
2. Warter Supply
UsbanWaterSupply _  %ofPoputalion |
Rural Water Supply % of Pepulation
Santtatiocn
g Household Toilet o o ZofHousehold {
= Urban Household Tollet _ . .
E Flush o L o %ofHousehold |
& Pour Flush SO TofHousehold |
B VIP Latrine o %ofHousehod |
2 Rural Household Foiler . L e
3 Flush . . | Foftouschotd "} T
g = Pour Flush — T Roftouschold |
g VIP Latrine B ZofHousehold |
b School Toilst L ] %ofPublicSwdent |
§ Public Toilet . L _ % of Public U;:l:ty e
% Solid Waste % of Populaticn
ot Water Supply .
§ UsbanWaterSupply _| BofPopulsfin |
4 ‘Rural Water Supp!y % of Population_ -
_ § Sanitation
B Household Toitat _ o - % of Household
| & Urban Household Toilet I .
Lo Fush A I ‘?239!);[9!45-:?10!(1 I
E Pour Flush L %ofHouseho |
= VIP Latsine S e} TofHousehold : |
- Rurol Household Toilet . _ i o
3 Flush . S%oftlousehord . | -
Pour Flush . v B of Household R
Vietawioe . .| %ofHousehald . )
School Teilet . e o | .. 5% of Public Student - o
Rablie Toter - et putic Uiy
Urhan Sewerage % of Urban Population
). |Percentage of Level 1 Wetls for Rebabilitation %
4. |[Percentage of Sector Managemenl Cost to Canstruction Cost
' Feasitility and Detail Design e} Bof Construction Cost |
Construction Supervision o of Construction Cost
5. |[Contingencies .
Physicad Contingency .. _ %ofConstructionCost |
Price Conringency _ Peccent per annum
6. |Communily Development and Training Cost .
Level HE e e e ) e of Constauction Cost .
. Levelsland 11 % of Coasteuction Cost
T 3 Level 1t System (Operating Cost) e b PesosHHfyew |
5} Lt\c_l_ﬂﬁl&jlgfg_@fa:c Pam!l:gulgmenl) . L _‘i‘gofCGnslructlon Cosl N
€ [Level 1l System {Spare Parts/Equipmeat) o L PesosMVyear
B |Ceve I Systera {Spare Parts/Equipmen) L _ Pesos/HU/fyeor
§ Public School Toilet Maintenance Cost N Ptsosfl‘ ciletfyear
| # [Public Utility Toitet Maintenance Cost " Pesos/ToileUyear
8. |Allocation factors/Percentages of IRA
VeomProviocid ; I
From Munsicipality and Brgy. %
9. |Funding Levels/Percenatges for Diffeccal Financing Scenarios

Ist Scenario

% Funding Avaifable

2nd Seenario % Funding Avaitable
Id Scenade R _ _ % Funding Available
AhScenwio . . _ | . %Funding Available
Sth Scenario o % Funding Available

2- 166




Composition of Well Sources and Specific Capacity

Standard Specification

Muricipality Area Source Proportion| ~Depth SWL Specific Capacity
- (%) {m) () (it/sec/n)
Rural Shallow Well
Deep Well B
Urban Shaltow Yell
| ) Deep Well S
Rural Shatiow Welt
Deeg Well ]
Urban Shallow Wit
Dezp Well
Rural Shatfow Well
Deep Well
Urban Shallow Well
Deep Well
Rural Shallow Well
Deep Well
Urban|  Shaitow Well
Deep Well
Rural Shailow Well
Deep Well .
Urban Shallow Well
| ) Deep Well
Rural Shaltow Welk
- Deep Well
Urban| = Shailow Weld
Deep Well
Rural Shatlow Weil
Beep Well
irban Shaitow Well
| Deep Well
Rural Shattow Well
Deep Well
Urban Shallow Well
Deep Wetl -
Rural |~ $hallow Well
Deep Well
Urban|  Shatlow Well
Deep Well
Rural Shaltow Wl
| Deep Weil
Urban Shaltow Wil
Deep Vel
Rurat Shallow Welt
. Deep Well
Urban Shaltow el n
: Deep Well
Rural Shallow Well
Deep Well
Urban Stisllow Well
L Deep Well
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Auvnual Distribution of Investment Cost Required by Sub-sector

for Medium-term Development Plan

Unit: Percent

Sub-Sector

Component

1996

Urban
Water
Supply

Level 1T System
Feasibility Study and Detait Design
Constryction & Supervision
Community Development & Training

Ruaral Water
Supply

Level I Facility
Detail Design

Construction & Supervision

Cormmunity Development & Tialaing

Level I System 5 o | §i§@§_ﬁ3§ﬁf§

Delail Design B
Construction & Supsivision

Community Development & Training

Total

Sanitation

Urban Houschold Toilet
‘Rural Household Toilet

Public School Toilet
PublicToilee
Disiafection of Levet 1 Wells

Deiail Desiga

Construction & Supervisio_n B
Commuanity Development & Training

Level 1 Safe and Unsafe Peccentage

Municipality

Safe Source Unsafe Source
%) ] (%)

Provincial Average
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kX
3.2
323

PROVINCIAL PROFILE
Natural Conditions and Geographical Featurcs

Topography and Drainage

RIVER
STAID
AGENCY

DRAINAGE AREA (S0 KM)

# oW

GAGE TYPE
START OBSERVATION
0BS LAST CONSIDERED

Table 3.2.1 Flow Data of Major Rivers

NAYOM RIVER
DISWIS4195PW025
8PN-DPWH, BRS

1

128

= NR
= JUL 1959
= 0CT187¢

LOCAT

10N

- LATITUOE
LONGITUDE

ELEV OF Z GAGE
GAGE OPERATION

STATU

§

REMARKS

11178 ABOVE MSL
STAFF GAGE READS 3X A DAY
NON-OPERATIONAL
RECORDS ARE GOOD

A AHHUAL OISCHARGE CHARACTERISTECS (Q I €U M/SEC)

MINOLY GAGEHT  DATE  RUKOIF

GUISGUIS, STA. CRUZ, ZAMBALES
15 48 31
119 58 48

wees DICATES MISSRLG DATA, KOT ICLUDED 1 CALCULATIOH OF STATISTICAL PARAMETERS

(Source Philippine Water Saurce Summary Data Volume {1, Departmaent of Public Works and

Highways)

VEAR PEAX GAGEHT. DATE  TIME  MAXOLY ~ MEAN
0 {MERS) 2 ¢ ¢ - (BEHRS) By
1971 25280 780  AUG-13 1oiee - 519 0.26 540 SER-25 12787
1972 w36 788 JULIE 14590 - 107 . 009 528 APRIB 17336
T 5280 470 SEP-08 ECE A { B 0BD 548 ARROEL Tt
974" 90000 994 OCT12  O7AM 41308 . 630 028 54D NAY.0l 15523
1915 10040 660 AUG-21 . OSAM 7w 93 09 545 HARDZ wgd
1976 - 25000 740 MAY-26 - O06AM 16800 - MLIZ - 00F - 436 MAY-03 . W34
1977 14504 696 - stR27 OMAM - 14002 12l 370 3534 WAVl o Ty
138 20080 730 AUGZ OSPM 15980 Tttt 156 - 538 v e
1973 23037 748 CAUG-T4  O7AM 17948 270 525 A0
{. HEAY HONTHLY DISCHARGE B CU H4/SECOND
jgit JAX e HAR ARR MAY JU AUG - SEF o(l NOY DEC
i 0.44 0.40 342 112 . 1.63 320 1458 335 4y 18 (%1
iz LB 033 1.02 003 050 245 5a8 0 1580 050 13 1.4 0.1
3933 - 0%2 ettt T 0.95 1.31 1.83 215 5.44 43y 16 I.2¢ 093
1974~ 083 070 0.45 0.33 06 04 e 040 2w NAY 1N 0.70
975 1074 103l 135 n YRY 810 §31 18w 1% 987 - 455 305
1324 203 144 052 0.4 W& N4y AN 1954 2743 113 3
1977 5.40 501 4 4% 5.0 108 1240 1252 54686 [ET B VS 128
S 1 450 418 9 14 398 807 1397 4yt verrmo oo
1978 312 1% 18 1B 630 939 324 .17 glg  freen e



RIVER = STO. TOMAS RIVER LOCATYION = DAELANAWAN, SAN'MARCELINO, ZAMBALES
STAID = 03ISWI145201PW094 LATITUDE = 14 53 54

AGENCY = BPW-DFWH, BRS LONGITUDE = %20 15 44

BRAINAGE AREA {50 KM) 117 ELEV OF Z GAGE 81.28 M. ABOVE MSL

GAGE TYPE
START OBSERVATION
OBS LAST CONSIDERED

NR GAGE OPERATION
APR 1947 STATUS
JUN 1972 REMARKS

STAFF GAGE READS 3X ADAY
NHON-OPERATIONAL
AECORDS ARE POOR

Ho 4 ¥ N

" 1} i H

A ANNUAL DISCHARGE CHARACTERISTICS {Q IR €U M/SEQ)

YR FEAL GAGENT. DM TNME  MAXOIY MEAK  MIRDLY GAGEHE  DATE  RUNOfF

@ [MEFERS) q Q G (MEIERS) M
]9]' 49.’ 205 JUL.2% YT ek 1A} !.43 MAY-23 T
]9)2 480 2w JUN-25 Iy e ;.35 ﬂ_?i jUN.‘22 hege

(. MEAN MONTHLY DISCHARGE IN (U M/SECORD

YEAR - AN - HBR WA AR A JUR Jut AUG SEP o(1 NO¥

0EC

971 015 . oW 032 0.26 0ttt 14 280 183 3133 280
19}2 280 zao 280 . kRErd LER RN ) 262 1edee 1408 q08ds LR Y] [ XN

'f"" INDICATES MISSING DATA, NOT INCLUDED {N CALCULATIGN OF STATISTICAL PARAMEFERS

280"

theed



RIVER = BAGSIT RIVER LOCATION = DAMPAL, PALAUIG, ZAMBALES
STAID = 03ISW352200PW032 LATITUDE = 5 25 52

AGENCY = BPW-DPWH,BRS LONGITUDE = %20 01 00

DRAINAGE AREA {SR KM) = 68 ELEV OF Z GAGE 8™, 0F 8M #1

GAGE TYPE = NAR GAGE OPERATION = STAFF GAGE READS 3X A DAY
START OBSERVATION = JUL 1860 STATUS = NON-GPERATIONAL

OBS LAST CONSIDERED JUNh 1972 REMARKS RECORDS ARE FOOR

A. ANRUAL DISCHARGE CHARRCTERISTICS (2 1N (U M/SEQ)

YEAR PEAK  GAGEHT.  DATE IME  MAXOLY MIAN  MINDLY GAGEHT. DATE  RUNOEHF

Q (REERS) a Q Q  (NEERS) MM
197y 4150 ne2 JUNRR s v 047 106 APR-13  weeeee

972 15425 115 MNB veres dn (7] 102 APRIT v

(. WEAN MONTHLY DISCHARGE il (U M/SECORD

YEAR  JAN fEg MAR ARR BAY JUN UL AUG 138 01 NoOY

0EC

1971 066 086 08y . on 450 1660 cccct ottt 147 6EF 4%

I W 085 0327 0B 072 1803 - crerr T weere versr denes oaesss

944 INDICATES MISSING DATA, NOT INCLUDED 1 CALCULATION OF STATISTICAL PARAMAETERS
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RIVER * STC.TONAS R.

LOCATIONS DALANAWAN ,SAN MARCELIND JZAMBALES
STA I0= D3SwIeS201PWOGR

GR1O NGz 310 3 APRON 40O M D75 OF OAR AT DALANAWAN

LAT: YL 59 54 LONG: 120 18 44

DRAINAGE AREA(SQ,XM)= 177, ELEVLCF 1 GAGE= B1.28 METERS ApvV MSL GAGE TYPE=

START OBSERVATION =APR 1947 GAGE OPERATION® GAGE READ 3X7OAY AGENLY EBPU~URSD
DS LAST CONSIDERED =0ff 1970 REMARKS= RECORDS FAIR,U/S IRR DIV. STATUS =QPERATING

Ae ANNUAL DISCHARGE CHARACTERISTICS (@ N (U.M./SEC.}

YERR PEAK ¢ GAGE M1, DATE TIHE MANLDLY 9 MEAK O MIN.DLY O GAGE NI. DATE RUNODFF
---- e “HETERS-  ---- T il “METERG- ---- M-
1947 287.240 4.800 oLt 0F 12K8N NYXLE L) Bhda it wsrdar  EMEIEE tirane
1948 432.20 5.800 SEP 02 12MN }0.48 24,08 S5.40 dsases MAR 29 644043
1oLy 278.56 LER AL JuL 27 G7Anm 210.88 14.0% 3.86 wsnaua MAY 04 2502.5
1950 372.50 5.3590 AUG 03 O5PH 282.60 15.31%9 .10 wesnan MAY 02 83n5.19
1951 241,80 4.290 AUG 03 O5eM 179,30 20.22 P.00  sesmas DEC 31 34Q2.1
1952 3t11.75 4,810 AUG 07 12AN 302.80 44.00 Jo54 ddsien JUK 03 7944.2
1953 ¢19.00 4.800 AUG 21 O53PH 197.40 15.10 2450 sesaen Jun 23 2890.4
1954 250.20 4.340 AUG 31 12NN 178.90 12.21 «20 1.0% JON 14 216%.3
1955 326,75 L.990 SEP 24 O7AM 222.60 10.70 WBE dekaes NOV 19 1706.5
1956 172.00 3.550 SEP 03 O7aA# 172.00 146.18 1,20 #riass FEQD O7 2891.1
1957 273.60 3.520 UL 14 O5PR 259.20 13.60 B3 areass APR 15 24232
1938 315.00 3.750 AUG 31 OSPR 309.40 2044 06 1.06 Fga 235 st1.s
1959 327.60 3.820 $eEP 03 OSPM 315.20 Tuk? 12 sasnse fte 27 1330.7
1940 662.00 5.6480 Jun 27 £20.30 23.75 1,00 sssaee APR 12 L2657 .4
1961 575,70 $.070 Jut C1 O5FPR 355.40 17.22 70 1.653 MAY 18 gsg .8
1962 855.00 &.400 JUL 24 12NN 783.40 21.72 0& 1.00 JuL 27 IBAT .4
1963 305.49 3.920 Sep 11 D5PH 334,840 20.3? 02 .80 AVR 25 3627.8
1964 2ee.00 3.600 JUH 30 O5PM 25%2.00 10.08 -0 1.00 MAR 11 1800.4
19465 288.50 3.270 JuL 27 0O5fM 217.80 T.96 «3% 80 BAY 12 14174
1986 270.00 3.500 PAY 27 12NN 237.60 12.45 47 58 aprr 07 2220.3%
1967 2¢5.00 3.250 AUG 03 12HN 160.50 }.82 0% .48 ACP ¥ AU
1988 10.0% 1.020 Jul 31 05PN 10.04 LA R AR 1R -1 Juh 23 rhrben
19469 L,.90 3.000 SER10 O5rn 4.85 1.13 .11 1.3 FED 17 291.2
1970 13.80 4 .000 SEP 02 12NN 12,40 1.45 .23 1.48 veEC 30 253.%
B, EXIREMES OF DISCHARGE AND STATISTIcaL PARAMETERS
EXTREME CISCHARGE [I[H CHS STATLISTICS PEAX 0 THAXLDLY O - BEAN-1 H[Q.CLT 1
MAX,Q = - 8%%.00 KIK.n o= . W02 TOMEAN FLM= I0R.AET 230.8R1 V6 %0 1.417
DATE = JUL 24,9942 OATE = MAY 09,178} SED.0EV.= 1R7.25%7 157,354 ey | IER
GAGE M= 6:40 GAGE H= .83 SKEWNESS = Tr.0Nn 1,413 278 V.77
IHSTANTAMEGUS PEAY SEVERAL B6AYS DEC FURTQS51S5+= "5.683 B .t L.AR2 t.%73
’ HO.vEARS = o2 2} 2¢ 23
€o MEAN MONTHLY OISCHARGE IH (UJM./SECOND
VEAR JAN FE8 ©  MAR APR HAY JuN JuL BUG SEP acy nov Lot
1947 senabs ansnes senead wedsen 14,73 2A.130 L9046 6724 T52.B% 41,74 3006 14.0%
168 1i.72 T4 511 7.59 T.35 0 13.03 40,18 TRO10 0 75.45  2A.37 16.82 T
1949 10.52 14.76 L8 R.24 13485 7492 23.35 2249 -22.80 24050 10,67 2.1
1950 6.12 5443 L.98 3.96 S5.46 47.65 58,77 109,19  75.9% “S$5.12  2a0.8% 2.1y
1951 17.87 16,36 15.29 14,78 17.94 -20.96 21,10 50,00 32.6T 15.4% 10.2¢ 7.0
1952 6,53 17.09 &3%.66 43,80 ¢3.49 31,08 73,10 127.63 - 68,92 32.32 24032 1B 0%
1953 1.3 11.95 10.19 £.93 8,44 146.40 24.34  MELDO 27.360 1NN 7.37° S.Th
1954 5.45 .87 0 4.33 3.23 2.83 2wl L.17° 27,60 33.04 7,07 23.54 12.1f
1955 5.60 3.35 5.68 6.03 407 12,71 15.B5  38.8% 18.74  12.24 2.28 ¢ 16
1958 3.33 1.50 L.43 6.03 T.87 8.63 15,04 29.49 62.04 -26¢.28 17.40 13.77
1957 1.33 1.36 1.28 1.59 1.12 12.69 40,59 &43.31 28.9%1 25.8% 251 1.47
1958 35 05 0t 04 05 29.00 &7.,60  51.25 AF.9Y 3.4 1.30 1.1
1959 45 23 1) «13 -19 «25 « 73 36.35% &43.%1 .38 1.04 o5 h
1960 26 +18 .25 " L1 27 38.8% . T.67 158,40 11.83° 41,71 12,09 5.18
1961 . 35 ce 12 W2 657 37.97 61.64.0 41.70 39.20 13,27 © 2459 1.48
1962 48 0,30 11 17 28 W29 87.86° 15.02 105.08 37.41 L.94 5412
1963 4,25 7:55 1.16 2.2% 00 55,15 43.30 23.20 AR.3SE 13.%7 3.6 0 AL42
1958 5.30 2.14 1.24 1.17 6.9¢ . 10.60 B.13% 40.10 15.08 18,02 7.88 S.Fd
19565 2.06 1.10 .82 52 1.87 5.07 36.67 9.27 13.14 L. 1.5 11,44
19460 .59 32 35 o3 36,28 11012 164540 22056 36,45 B.lh 15,94 1,7
1787 .30 59 22 .38 1% 12,48 7.43 13.P4 1.57 T4 3.97 2.7t
1948 W57 .58 b A5 1.05 00 BT sssase ssares - 1073 A7 oY
1769 20 14 + 3 «59 1.08 ) V.00 2022 2.%8% 2.50 YA .37
1970 +30 « 91 98 1.05 1.07? 1.33 1.87 2.25 L.37 t.48 A7 N2
MEAN L,09% .26 Labb £.78 7.6 16,86 29.91 45,73 L1.03 18.7¢ 9.78 451
ST.DEV: L.77 5.53 .30 9,67 11.02 15.81 246.85 39,48 27.86 1L.68 .30 5.%%
SKEWSS = 1.477 1.400 3Y.682 13.803 2.301 « 280 17 14570 wAH3A 83 367 TR
KURTSS = S.055 L.018 17.765 18.634 B.320 3.335 2.760 5.540 2.EI0  3.414  2.%04 2.712?
NQJYRS= e 23 2} 23 24 24 2L 2% ¥ 24 24 74

HOTE: s#ase INDICATES MISSENG ORTA,MOT INCLUGED IN CALC OF STATISIICAL FARAMETERS
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NCY

o W a

BUCAD RIVER
D35W151200PW093
BPW-DPWH, BRS

10CATION
LATITUDE
LONGITUDE

#Houon

SAN JUAN, BOTOLAN, ZAMBALES
15 i6 40
120 65 10

“*** INDICATES MISSING DATA, KOT INCLUDED i CALCULATION OF SYAWISTICAL PARAMETERS

JNAGE AREA (SO KM} = 6315 ELEV OF Z GAGE = 10.20 M ABOVE MSL

iE TYPE = NA GAGE OPERATION = STAFF GAGE READS3X A OAY

ARY OBSEAVATION = OCT 1855 STATUS = NON OPERATIONAL

LAST CONSIDERED = QCT 1878 REMARKS = RECORDS ARE PODR

A ANNUAL DISCHARGE CHARACIERISTICS {Q 1N CU M/SEQ)
R PAK GAGEHT. DATE  TIME  MAXDIY MEAN MINDLY GAGEHT DATE  RUNOSF
0 (METERS) a 0 0 (MRS U]

IVT6000 380 JAKO) SR 00 280 MPR3 TR

22 ANeAN IEXE Y] . sSHEE0 8 [ EXNE] (A EN XY LEERR] . seedw

739000 550 SEPpd 5000  tete 460 502 JAN-O1  tere

]4 IIEY XY Apvs . (XYY X3 [EENT ast N syeqad . T IER)

31813 549 AUG-I0 813 4573 812 S29 0 DECH )

359509 SS7 - MAY-4 9409 SRI8 1500 400 MAR2Z - 3022

779583 5§ AUG-04 9523 5280 3140 480 JUN-20 2744

7 4580 SO0 AUG22 OTAM 4580 3156 2050 422 HARIZ 1818
7p 80 639 UGS O7AM 21180ttt 33 481 BT Tt

¢ IAEAN MORTHLY DISCHARGE 1H (U M/SECOND

WOUNHE MR MWW TTUNTTTION TR S8 o WY D
I 1025 8589 1504 1230 et et 5@ 138 3131 8535 Al 3983
9?2 "l.l. ~..L..-I l.l'l' T899 .C.IO.' AhTse dseae LAEE R ] L X3RN ] LSRR (R X X] shve*
3 4704 4068 8758 6986ttt 4851 1568 8831 8129 8107 M4 7120
974 *hang IO-III' lICil’: agens LI NN LERYR] [EX X R l.iilI ..‘Ol.l LIR NN BEEER asdEe
OIS 8h36 G04 HAA  L0T 8459 6396 BT7 M35 MB el K3 61
o756 SSA1 SI9L. 4074 - M445  B46B 6609 7183 U393 7131 6805 5525 AW
977 3853 302 345 3506 A2 3214 4430 8786 912 890 1585 2SI
§18 2275 2238 2185 2162 46 - 7S 3281 4216 B2 4162 045 N8
99 RIS 3857 ctett L3845 4040 4335 4324 16100 19933 Bpog  ttvte cere



RIVER = BULAD R, LOCATEDONT SAN JUAM BOTOUAN JTAMBALES

$Ta o= 03SWISI1200PWD93 GRID NOW= 3 9 2 AGT 7 KM5,3€ OFf TOWN AND APROX 3 XMS FR.BO, SAN JUA
LaT: 15 146 &0 LONG: 320 5 10 N

ORATHAGE AREA(§Q.XM)= 515, TLEV.0F 1 GAGE= 10,20 RETERS ANV MSL GAGE 1YPE=

STARY CBSERVATION £GCT 1955 GAGE OPERATJON= GAGE READ 2X/DAY AGEHCY 2PW-W25)H
0DS LAST CONSIDCRED =ptl 197D REMARKS= RECORDS FALR STATUS =0PERATLHG

Ke ANKUXL OISCHARGE kHARAC!ﬁﬂIS'l{S (0 IN CUM./SEC)

SUNDTF

RS Y

[EREEE]
2786.8
1620.1
31143.9
1480.4
3332.3
3824.5
Jesra
3£95.3
| LA
1325.1
LB B
L PR 24
245%.5
1300
2195.0

PRI

TEAR PEAK © GAGE HT, DATE TIME MAX.DLY 9 HMEAN O MIN.DLY Q GAGE KV, DATE
L e ~METERS~- ==-= B I P L L PP L R ~HETERS—- ----
1955 LZ.BO 3'000 ct]’ 25 0?‘“ [ FEERYN N 2R RN N [ X EEER] (RN NN
1958 1092.40 §.420 SEP 00 O7AR 245,469 54.20 B8.56 2.54 APR 20
1957 7465.80 5.660 JUL 15 0tem $686.,40 &£0.07 1.04 2.358 HRY 28
1958 1087.70 b5.410 SEP D& UdaM 121.80 73.38 9.18 erassa MAT 2}
1959 701.30 3.450 AUG 30 05an 590.20 ye.r? B.50 wenrer KER 23
1960 2525.30 8.970 AUG 18 727.80 $4.81% 7.30 | 2.68 AFR 1}
1961 1139.40 6.520 SUN 26 D5eM 992.00 56479 Q.00 svases uar 0
1962 2¢20.44 B.340 Jur 24 0tan 2220.40 8372 10.74 2.6 nae 11
1963 1380.00 i.000 AYG T4 OS5FH 782.00 10.31 10.00 3.0 Her 01
19es 1018.40 &390 ocl 22 Q3IM 440.00 34,3 450 L.32 ner 0%
1965 607.00 $.000 JuL 14 06an 233.90 30.77  13.30 3.6 A7
1944 494.00 5.700 Ser 13 05en tasaans sranera 11.50 3.50 AER 1S
1947 529.00 5.800 JUN 0B O5PH $22.00 77.49  16.00 3.68 HAD 15
19468 748,50 5.350 T AUG 22 05fM © 731.80 $1.47 11.090 3.37 Juy 23
1349 FRL.50 5.250 RUG 07 Q&AM 635.00 29.88 10.035 5.28 SEF 14
L 3] 835.00 6.760 SER T3 046AM 302.00 L&.52 g.510 }.20 Abh 23
B, EXTREMES OF DLISCHARGE AMD STATJISFICAL PARANFETFBS

EX19ENE DISCHARGE 14 (1S STALIGIICS FEAY N tpeaply oA et o py
MAX.O = 2%25.30 MM = 6.50 MEAN FLW=  977.774 TEALTFT T EL:00
CAVE = AUG 16,1980 OATE = 0CT,03, 17964 SID.DEY,. = &25.10n A52,%22 1400
GAGE = 8.99 ° TGAGE = L4332 SYEMHESSH 1.302 2.%40 -.540
INSTAHNTANL DUS ©EAK SEVIAML DAYS ATR-MAY FAVE 3 5,312 11.221 T

: : HO . YELRRS 2 14 14 13
Co HEAN MONTRLY OISCHARGE IN (U .M./5ECOMD

YEAR JAH FEB HAR APR HAY yn L AUG sEr act HOV
195%5 BAREA S ADakhA ARVASE SARAAE PEAAA A AN ANeR RS AESE ANAVEN PREERE DB 4 as 17.27
1954 13.52 11.31- 9.4 9.29 -10.96 10.73 SQ.Ii 0454 341,00 57.75 30.Fe
1957 18.90 14,83 12,90 13.95 10,30 77.23 106.39 183,467 132.86 B7.64% IL,04
1958 186.80 14.B8  14.40 11.0% 10.03 132.13 201.&6' PB4 253,25 Il 9h 35,20
1959 1662 12,97 10,74 #.15 10.02 10.%8. 19.!?_!22.?6 t12.48 32.03 19,91%
1940 1,23 10.02 9.3 8.42 .62 54,620 44.53 S54LES BR.AT 122.%7 3i.12
1941 17,41 13.66 12,01 -10.0% 34.460 94,76 168.40 328.19 187.0% 72.12 35.67
1962 1998 16.5% 15.07 14,40 31.94 15,24 285.37 152.6F 127.40 S51.18 26.85
1943 15,019 13,62 12,37 11.30 13.48 167.67 11B.46 116,20 1EQ.2Y 77.32. 93.29
1984 20.640 14.B0 8.81 6.3%5 1180 30,48 - 4N tT7 B34.34 1%.37 51.22 31.1}
1965 23.80 A7T.7% 16,20 14,80 16.98B S58.95 4&3.24 59,23 S2.,0r 21.22 13.%5)
1985 12.43 12,23 11.93 11.93 esaeei 33,83 82,350 154.97 289.26 12.8% 33.:7
1967 31235 24,40 17,24 20,17 29.97 229,22 956,22 123,18 131,84 10R.45 0 81.%2
1968 25.9%1 18.70 14.17 16,879 - 18.53 V3,75 42.76 232.87 "137.44 61.17 19.84
19569 16,52 13.26  12.70  12.34 15,26 35,53 L6.L4 380028 2114 22,45 11,12
19710 10.04 .73 q.67 P.56 F.56 22.82: 31,34 6. 81 24742 72.0% 37,01
MEAN = T?7.%0 14,59 . 12.48 11.87% 15.07 65%.35 91,895 143,67 154,71 65.75  35.3%6:
ST.OEY: 5.68 3.1 2.8} 3.5¢ FL.76 64,90 75.20 73.De  P5.84  2R.0T 0 22.1%
SKEWSS= 886 1,288 311 1. 1.905 1,490 - 1,897 1.EB48 387 232 1.738
NyRISS+= 4.300 5,812 2.496  5.856 65.257  5.105 - 3,386 T.85 3,087 3,560 &6.249
KRO.TRS: 15 15° 15 15 14 1% 13 15 15 15 14
BOTE: svede JNDICATES MUSSEING DATA,NOT [NCLYUDED IH CALC OF STATISTIICAL PARAMETERS
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e

A. ANNUAL DISCHARGE -

GRID NOW7 3} B

LoNG: 120 1 0

68, ELEV.OF 2 GAGE=
1960 GAGE OPERATION=
1920 REHARKS =

LOCAT|ON:

2 ABT $4 xXMS5 FR TQUN

CHARALTERISTICS (0

3.00 METERS OF A.nM,
GAGE READ 23/DAY

RECORDS FALR,BN 1-10 N RSB

R Y.

PAMPAY  PALAUTIG.ZAMBALFES

KO, 1GAGE TYPE=

RiVER = (ADSTT R.

STA §02 0XSw15220tPw0R2
LAT: 15 25 5¢

DRAFNAGE AREAC(Sq.XM)=
STARY OBUERVATION = UL
OBS LASY C(QHSIDERED =0DEC
TEAR reEee A GAGE HT
e me———— ~HMETERS -
1960 9L.40 3,020
1961 54.80 2.590
1962 ta5.R0 3.720
1963 20500 4,000
P4 104,50 saraaan
19439 £3.70 2.040
1948 111.2% 2+350
1967 60,00 LA AL RS ]
1968 g4.195 2.1710
1269 853.40 2.:080
1970 $1.30 2,140

EXTRENE DISCHARGE

MAN O =
OATE =

GAGE h=

IMSTANTANEQUS FPEAK

185.80
SEP 05,19
1.72

« DATE

oct
JUN
SEP
ARG
ANG

AUG

MAY
AUG
AYG
L
AUG

0?24m
07AM
15 0Oran
07an
Q5rH
g1 05en

o5en
a7AM
1533, ]

T
X
§.32
IR
10,42
assandan
.31
8.04
5.54
7.72
8.3%

mlu.bL Y

AGENCY =OPY-wP 5D
STATUS sHFERATING
WISEC L)

a GAGE NT. DATE ETUL T
- ~METERS=- ---- -—HM--
LR R NN ] LA RN N ]
1.20 AR 1 sseaws
1,14 ‘MAR 28 2754.0
1.13¢ MRD 24 DR

R M o211 Lp79.2

1.0¢4 nag 23 rearan
tiGt HAR 13 2008.2
1.04% net 314 173846
1.0¢4 FLL I 5 0Lt 5
1.0¢ nee 01 M EARS
(KN REE D ¢ P24

B. EXFREMES OF OiSUMRGE AND SF_!FISIItf.L TAPANETEDRS

th (s STATISEICS Pr

t
MIN.2 7 27 _ HEAY FLM= 108
62 OATE = HMaR 12,1969 SEDaDEV. s~ 51
GAGE H= 1.0¢ SYEWHESS T 1
SAME WIlH PREVIOUS Y YURIOS)S = 5

: NO.YCARS =

AV 0 "

careae
.51

« 560
W34
&.33
U7

£ 94
.00

Arsane
sasans
T
1.98
4,48
2.73
}.50

2.09%

1.79
2.5%
2,85

8.22

17.52
BN NN
41,05
23.98
5.59
22.78
31.27
16.02

KURT 5% =

9

10. 41
A7

L.n%
8

LN I RLCENE: B b L A A
71.57! 7.L45 STAT
26.551 1.72)% .25
-1.%353% -.038 IR EY/
4,892 S.421 2.7

[4 4 19

1Al net iy L
.-io-[ TR RENR] L2 .25
14,27 Fol2 essress T 1,25
22.00 LLL5 2.40 .27
sharee 4.4 L £.57
21.686  11.11 5.8¢ $.77
24 L ET aeaaai YL R
77U 5,26 6.9B R.12
158.91 2.33 2.1¢ t.17
18.5% - A.20 1.67 A
17.3¢ r.e%  3.BL L 2417
15.90 8.70 1.2% f.22

14.2%9 .17 3.97 2.%2

5.179 215 1.71 hAy ]
L] <514 LYY LA
$.598  3.HNY 3.8 LOPH)

9 ? Q 10

{HDLCATES MISSING DATA,HOY LNCLUBED IN CALC OF STATISTICAL PARAHETEPS



Sccio-economic Conditions

1.13.2 Basic Infrastructure
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A5 Health Status
151 Morbidity, Moertatity and Infant Mortatity

RIS )

Fabte 3.5.1 Morbidily, Mortality and Iofant Mortality by Muncipality (Annual incidence per 100,000 persons)
Filename: HEALTH.XLS

[Content: Health - Marbidity and Moxtality PAGE: 1 OF | ]
HDATA COLLECTION LEVEL: Provincial o MENICIPAL NO DATE: e
IREGION NUMBER : 11t NAME ; _
PROV.KO.: 0371 BARANGAY NO.: NOT APFLICABLE
NAME : Zambales - NAME: NOT APPLICABLE
Anpual Incidence peg 100,000 People
Cause br‘:;_{) Biscases DI:.:S:‘ Name of Diseases (-Group) W ?;:::l:w Morbidky Muartality Infant Mogtality
Infective A0l 2-4 Typhoid/Parathyphoid X .
and A Q2 _{5-1 Dysentary X 8
Farasitic AQ3 8- 10/ Intesting) Parasites X 4,751
{QOL-135) A4 11-13/ Diarrhea X B.438 3 3
A0S H4-16f Toberculosis i 1z 168 .
A06 - |17-19/ Conjunctivities X 21
A0Q7  {20-22/ Whooping Cough _ 9 B
A0S - {23-25/ Throat/Far/Nose & ]
A9 |26-28/ Tetanus 96 L
A10_ [29-3 1] Septicemia _ 17
A.(1__ |32-38/ Cholera X o
A 12 [38-37i Varicella, Chickenpox 116 e
A3 13407 Measles : : 121 13
A4 141-4¥ Dengoe Fever X 45 4
A LS 4446/ Viral Hepatitis X 32 -
A6 [47-49/ Mataria X 113 !
A17  }50-527 Schistosdmiasis X :
A.i8  |53-55/ Filariasis X
A LD ]56-58/ Vencrial Diseases 16
A20 5961 Other Bacter s Vieal Dis. :
Neoplasmis . [B.01__ 162-64 Malignant Neopfasms : 6
{140-219) B.02  {65-67/ Leukemia . N
Endocrine, NutsitionallC.01_ [68-70/ Diabetes Mellitus : ]
& Metabollic C.02  |71-2M Nutritional De(iciencies 1812 4 2
(250-279) - 1C.03}  }74-76/ Endocrine Disorder .
" Blood & Blood = {D.OI 17-7% Anceias ) 4891 - : 12
Forming Organs ! ] '
‘g . (250-289) ' : _
* Mealal Disorder  [ECI _ .
{250-319) ‘ .
Nervous Systern . [F.O![€D-82/ Meningitis : N > T 9
& Sense Organs  |F.02 . [83-85/ Nervous Systein Co 70 kY
C(320-389) L : . : : ‘
Circulatory ~ |G.O1 - {86-88/ Heant Diseases . - 458 ¥ b ]
Systems (390-459) [G.02 © 18991/ Vascular Diseases : 220 .
HO ]92-94/ Bronchitis L . XA 15 o
Rospiratory  [IL02__ |95-97/ Pacumonia 731 335 11 3
Systems - [11.03 1 [93-100/ Iafluenza ) 1,384 | .
(450-519) - {B.04 101103/ Obstruciive Pulmonay 15,293 18 18
HO5 -~ |104-1067 ARI : . As - : j
Digesave | [101 107109 Appendicitis :
Systein 102 |110-142/ Gastroent. Colitis 440 .
(520-579) [L.OX 113-115/ Chronic Lives Disease ‘ : -
104 116-§ E87 Other Briges. Diseases: ] 40 15
Genito-Urinary - |1.0] 119-12 14 Kidneyl Nephritis .
Systein (5§0-629) 11,02 122124/ Urinary Infections 202
Complicationof  {K.O} 125-127 Prematurity : o 23 23
Pregnancy & the
Puerperium {(630-676)f i . -
Skin & Subcatancous [1.91 128- 1304 Skin Discases ; X . 4,272 _ : . o
Tissue {630-70%)  [L.O2 E31- 033 Scabics X _
Mosculaoskeletal & (MO |134-536/ Arihrop, Rhesmatisin
Connective Tissue ' : : ‘ ]
(H0-739) ' : -
Congenital AnomaliesIN.OI 137-3 39/ Congenital Ancimalics 1B 11 K]
{740-75%) i
[P.01 __]140-142/ Birth Trauma ]
Cestain Cavses of 143-545/ Bicth Injurics & Dnfficult
Prenatat .02 Labar _ o .
Morbitity & Motatity [P0} 146-14% Resp. Fetus/Newborn .
g G60-779) - IP04 {159-151/ Other Peroatal Covses ' 26 15
“ Symptotms & Q.01 1152 )54/ Senility o 47 19 o
Iil-defined Condition |Q.02 135152/ 111-De finad Conditon
(780-799) . . - |
Accidonts, Poisoning [ROt - [158-160/ Buras
& Violence RO2 [61-163 Suftor. Foreign Body _
(800-999)  |RO3  [164-166) Other Accidenls . 96 o 1 |
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3.5.3 Heallh Facitities and Practioners
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Environmental Conditions
3.6.2 Water Supply
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EXISTING FACILITIES AND SERVICE COVERAC

4,2.3 Sanitation Facilities and Service Coverage

4.2 Sanitation and Sewerage
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